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Setting up an Analyzer Project

This documentisto splitintotwo main parts. The firstdeals with setting up youranalyzer project —
gettingthe build environment set up on Windows, Mac, and/or Linux.

Then second part deals with writing the code, and the details of the SDK.
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Visual Studio

This section deals with setting up a Visual Studio project from scratch. The SDK already includesaVisual
Studio project that should run build and run out of the box —but if you want the details this sectionisfor
you.

In addition, the following section discusses how to automatical ly change all the source filesto match the
name of youranalyzer—which can be a nice way to get started on a new analyzer.

1. Ifyou haven’talready, downloadthe latest SaleaeAnalyzerSdk-1.1.x.zip file and extract to this to
your desktop, orother convenientlocation.

2. launch VS2008 —we’re usingthe C++ expressversion.
http://www.microsoft.com/express/Downloads/ (as of the time of this writing, there is VS2008
tab still on the page).

a. File->New-Project
Visual C++; Win32
Win32 Project (undertemplates)

Name: {YourName}Analyzer (Example: SuperSerialAnalyzer)
Location: Desktop\SaleaeAnalyzerSdk-1.1.x\

Make sure Create directory forsolution is not checked.

Press OK.

m -0 o0 o

Project types: Templates:

Visual C++ Visual Studio installed templates

CLR .EWinBE Conscle Application EWirﬁZ Project
Win32

My Templat
General o Emplates

ZH Search Online Templates...

MyAnalyzer
Ch\Users\Joe\DesktophSaleaeAnalyzerSdk-1.1.5

MyAnalyzer Create directory for solution

Cancel

3. Ontheleft-hand plane, click Application Settings
a. Under Applicationtype, select DLL
b. Under Additional options, check Empty Project
c. PressFinish
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CvErview Application type: Add common header files for:

application Settings () Windows application
() Console application
@D

() Static library

Additional options:
Empty project

l Finish H Cancel

)

your new projectfolder.

Next, let’sgetoursource filesinorder. Inthe root of the SaleaeAnalyzerSdk folderthereisa
foldercalled source, and afile called rename_analyzer.py, copy and paste both of these into

Organize « 7l Open Share with = Burn MNew folder j:
- -
i Favorites B s documentation include
Bl Desktop File folder | ’ File folder
=] Recent Places
| lib - MyAnalyzer
- . L File folder F File folder
. Libraries =
3 Docurnents
. i k source \ ws2008
o) Music ’ File folder F‘ File folder
[e=| Pictures
5]l Saleae Website build_analyzer.py refresh_contents.bat
H vid b ﬁ Python File Windows Batch File
1aeos 351 KB 503 bytes
rename_analyzer.py
% Homegroup ¢, Python File
2 Mark (MARK-PC) 196 KB
2 items selected State: 28 Shared Shared with: Speedy

Date modified: 1/3/2011 6:10 PM - 1/15...
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Kol b » SeleachnalyzerSdk-11.5 » MyAnalyzer » - Search MyAnalyzer o
Organize = @ Open Share with + Burn MNew folder v @'
¢ Favorites 1~ ﬁ rename_analyzer.py —=  MyAnalyzerveprojJoe-i7-PCloeus

Python File —| er
B Desktop 196 KB Visual Studio Project User Option...
=l Recent Places
: MyAnalyzervcproj MyAnalyzer.suo I
— 5| VC++ Project Visual Studic Solution User Options

4 Libraries = = 384 KB 7.00 KB

3 Documents MyAnalyzer.sin — = MyAnalyzer.nch

JX Music \ Micresoft Visual Studie Solution — | VC++ Intellisense Database

=] Pictures 890 bytes — |11.0KB

il Saleae Website e

= b
B8 videos ' File folder

& Homegroup
2 Mark (MARK-PC)

2 items selected State: 28 Shared Shared with: Speedy
Date modified: 1/3/2011 6:10 PM - 1/15...

Automatically changing the file names and contents to match the name of youranalyzer
isvery helpful and saves a bunch of time and effort. The rename_analyzer.py script
doesexactly this. Unfortunatelytorunityou’ll have toinstall Python 3.x. We’ll dothat
now.

Go to http://www.python.org/download/ and download the latest 3.x Windows
installer, and installit.

We’ll wantto add Python to our path environmentvariable.
e On Windows 7 or Windows Vista:

1. Start Menu->(right click on) Computer->Properties

2. Choose Advanced System Settings. It’'ll be onthe leftsidebar.

3. Clickthe Environment Variables... button atthe bottom of the Advanced
tab.
Under System Variables, scroll down and doubleclick the variable Path.

5. Attheendof the Variable value string, add ;C:\Python3x (a semicolon,
and the absolute path of your Python installation)

Edit System Variable “
Variable name: Path
Variable value: Vindows Performance Toalkit\;C: \Python34 |
Carcel

e On Windows XP:
1. Rightclickon My Computer, andthenclick Properties.
2. Click Environmentvariables, onthe Advanced tab.
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3. Under System Variables, scroll down and doubleclick the variable Path.
4. Attheendof the Variable value string, add ;C:\Python3x (a semicolon,
and the absolute path of your Pythoninstallation)

Now we’llrunthe rename_analyzer.py script. Open aconsole (Start Menu ->Run, type
cmd, press enter (Windows XP), or Start Menu->Search programs and files (text box),

type cmd and press enter (Windows Vista & 7).

¢ Navigate toyournew project folder: cd Desktop\SaleaeAnalyzerSdk-
1.1.x\YourProject

BN C\Windows\systern32\cmd.exe |££|th

Microsoft Windows [Uersion 6.1.76881]
Copyright (c> 2809 Microsoft Corporation. All rights reserved.

C:~Users~Joe>cd DesktoprSaleaefinalyzerSdk—1.1.5“HyAnalyzer

C:~Users~JoesDesktop~BaleaefinalyzerS8dk-1.1.5\Myfinalyzer>_

e Type: python rename_analyzer.py

BN C\Windows\system32\cmd.exe - python rename_analyzer.py |£@éj

Microsoft WYindows [Uersion 6.1.76881
Copyright <c> 2889 Microsoft Corporation. All rights reserved.

C:sUsers~Joercd Desktop~SaleaefinalyzerSdk—1.1.5“MyfAnalyzer

C:sUserssJoesDesktoprSaleaefAnalyzer8dk-1.1.5\MyAnalyzer>python rename_analyzer.py

hat would you like to call your new analyzer?

>>The files under ’/source’ will he modified to use it.
>>Examples include Serial, MySerial. JoesSerial, Gamecube, Wiimote. 2Wire, etc.
>>Do not inclide the trailing word ’‘Analyzer’ this will be added automaticly.

{press CTRL-C to cancel)

Your new analyzer name: _

e Follow the instructions—enteryouranalyzer name (this should match your
project name you created earlier). Do not enter “Analyzer” atthe end —thisis
implied, and willbe added automatically. Forexample, for SimpleSerialAnalyzer,
enter SimpleSerial.

e Enter thetitle todisplayinthe Add Analyzerdropdowninthe Logicsoftware.
Thisis really easy to change later.
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What would you like to call your new analyzer?

>>The files under ’source’ will be modified to use it.
>>Examples include Serial, MySerial, JoesSerial, Gamecube, Wiimote,. 2Wire,. etc.
>>Do not inclide the trailing word ’‘Analyzer’ this will be added automaticly.

{press CIRL-C to cancel)>

Your new analyzer name: My

lhat is the analyzer’s title? <{as shown in the add new anlayzer drop doun’
>>Examples include Async Serial, I2C, Joe’s Serial. Gamecube, Wiimote, 2Wire. etc.
{press CTRL-C to cancel)

Your new analyzer’'s title: Joe's Protocol

C:sUserssJoesDesktopsSaleaefinalyzerSdk—1.1.5\Myfinal

e. Closethe console,andopen the source folderinside your projectfolder. Noticethatthe
file names now match your project. Internal changes have also been made —class

names, etc.

Kl > seleoermabeersaicis b Mypnabzer s source <o oo o]
g—g |_ }+ SaleaefnalyzerSdk-11.5 » MyAnalyzer » source | |

Organize = Include in library ~ Share with + Burn New folder =~ O @
X Favorites it Mame ° Date modified Type Size
Bl Desktop = MyAnalyzer.cpp 1/15/2011 6:42 PM 3KB
= Recent Places E ] MyAnalyzer.h 1/15/2011 6:42 PM Header 2KB
2| MyAnalyzerResults.cpp /2011 6:42 PM ource 3KB
w9 Libraries o MyAnalyzerResults.h f15/ 42 PM Header 1KB
| Documents G| MyAnalyzerSettings.cpp 1/15/2011 6:42 PM C++ Source 2KB
-. Music ] MyAnalyzerSettings.h 1715/ PM Header 1KB
k= Pictures ] MySimulationDataGenerator.cpp 1/15/ 42 PM ource 3KB
Saleae Website (] MySimulationDataGenerator.h 1/15/2011 6:42PM  /C++ Header 1KB
B Videos i
g items Stste: 3 Shared

5. Nextwe’lladd oursource files to Visual Studio
a. Under Solution Explorer, deletethe folders Header Files and Resource Files. We won’t

be usingthem.

| e Mydnalyzer - Visual C++ 2008 Express Editiol

File Edit WView Project Build Debug Tool:

F-E-E5d @ .
Solution Explorer - MyAnalyzer >~ 1 X
= |
J Solution 'MyAnalyzer' (1 project)
- o
i [ Source Files

b. Rightclickon Source Files and choose Add->Existing Item.
c. Navigatetoyoursource file, and select everything, including the headers
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File Edit View Project Build Debug Tools

- - 5 @ % G 9 - o

Solution Explorer - Selution 'MyAnalyzer' (.. ~ 1 X
=] &
[54 Solution 'Myfnalyzer' (1 project)
B- ZH MyAnalyzer
- (o N
e € MyAnalyzer.cpp
- ] Mydnalyzer.h
- €] MyhnalyzerResults.cpp
-« |n] MyAnalyzerResults.h
- € MyAnalyzerSettings.cpp
- ] MyAnalyzerSettings.h
- € MySimulationDataGenerator.cpp
- |h] MySimulationDataGenerator.h

T .

T

=

=r

6. Now we must tell Visual Studio whereto look forthe SDK’s headerfiles.
a. Rightclickon the project name, and select Properties.
b. Inthe Configuration: drop-down, choose All Configurations (This saves us from needing
to setit up forRelease and Debug modes separately.)

MyAnalyzer Property Pages - = —

Configuration: ’AII Configurations V]

c. Under C/C++,selectthe General Item.
d. InAdditionalInclude Directories, type $(ProjectDir)..\include
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-
MyAnalyzer Property Pages

. —— — A W —

[ER=x)

Configuration: | All Configurations

~| Platform: [Active(Win32)

'] ’ Configuration Manager... ]

Commeon Properties
Configuration Properties

General

Debugging

C/C++
General
Optimization
Preprocessor
Code Generation
Language
Precompiled Headers
Output Files
Browse Information
Advanced
Command Line

Linker

Manifest Tool

XML Document Generator

Browse Information

Build Events

Custom Build Step

4 I 2

Resolve #using References
Debug Information Format
Suppress Startup Banner
Warning Level

Detect 64-bit Portability Issues
Treat Warnings As Errors

Use UNICODE Response Files

Additional Include Directories $(ProjectDir).\include| E]

Yes (/nolego)
Level 3 (/W3)
No
Mo
Yes

Additional Include Directories

than one.

(Mpath])

Specifies one or more directories to add to the include path; use semi-colon delimited list if more

[ oK ][ Cancel H Apply ]

for 64-bit Logic software, you will link against Analyzer64.dllinstead.
Expandthe Linkeritemandselect General.
b. Under AdditionalLibrary Directories enter $(ProjectDir)..\lib

a.

C.

-
MyAnalyzer Property Pages

e — A ———

(A=)

Configuration: | All Configurations

* | Platform: |Active(Win32)

'] [ Configuration Manager... ]

Commeon Properties
Configuration Properties

General

Debugging

C/Ce+

Linker
General
Input
Manifest File
Debugging
System
Optimization
Embedded IDL
Advanced
Command Line

Manifest Tool

XML Document Generator

Browse Information

Build Events

Custom Build Step

4 I 2

Qutput File

Show Progress

Version

Enable Incremental Linking
Suppress Startup Banner
Ignore Import Library
Register Qutput

Per-user Redirection

Link Library Dependencies
Use Library Dependency Inputs
Use UNICODE Response Files

Additional Library Directories $(ProjectDir).\lib| E]

S(OutDir)\S(ProjectMNarme).dll
Mot Set

Yes (/NOLOGO)
Mo
No
No

Yes
Mo
Yes

Additional Library Directories

Specifies one or more additional paths to search for libraries; configuration specific; use
semi-colon delimited list if more than one.

(/LIBPATH:[dir])

[ ok [ Cancel |[ Apply

Under the Linkeritem,

selectInput.
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d. Under Additional Dependencies enter Analyzer.lib or Analyzer64.lib depending on your
build platform

[ MyAnalyzer Property Pages e —————— | R |
Configuration: | All Configurati ~| Platform: [ Active(Win32) ~| [ Configuration Manager... |
Commeon Properties Additional Dependencies E]
Cenfiguration Properties Ignore All Default Libraries No
General Ignore Specific Library
Debugging Madule Definition File
i C/C++ Add Module to Assembly 1
Linker Embed Managed Resource File
i General Force Symbol References
I Input Delay Lozded DLLs
; . y
Mann‘es!‘_ File Assembly Link Resource
Debugging
System
Optimization
Il Embedded IDL I
Advanced
I Command Line I
Manifest Tool
i XML Document Generator |
Browse Information
Build Events
Custom Build Step Additional Dependencies
Specifies additional items to add to the link line (ex: kernel32.lib); configuration specific.
4 m r
[ ok [ cancel || Appiy |

Ok! At thispointeverythingissetupandyou should be able to build and develop yourcode. You
should be able to build forrelease, ordebug. Use debugfordevelopment (see furtherdown forhow to
debug), butalways use release for real world use as it will run much faster.

File Edit View Project Build Debug Tools Window Help
i) Back ) ] ¢ @ A°| @ HowDol » Q Search [Index & Contents [Z] Help Favorites | =f (7 <3 | %J MSDN Forums i, -

(E-iE-EHd | B9 -~ -5 b Debug - Win32 - | [ free |

Solution Explorer - MyAnalyzer -1 x
|
[5] Solution 'MyAnalyzer' (1 project)
B (54 MyAnalyzer

= [ Source Files

i €] MyAnalyzer.cpp

|ﬂ MyAnalyzer.h
C_ﬂ MyAnalyzerResults.cpp
|ﬂ MyAnalyzerResults.h
ﬂ_ﬂ MyAnalyzerSettings.cpp
[h] MyAnalyzerSettings.h
€ MySimulationDataGenerator.cpp
[n] MySimulationDataGenerator.h

xoqj00L ;i€ [1ai01dxa aseceied g,

g Solution Expl... [ Class View [ Property Man...

Show output from: Build -l @ A xE

1>Microscft (R) Windows (R) Resource Compiler Version €.1.8723.1 -~
1>Copyright (C) Microseft C ien. 211 rights

13TLinking. .

1> Creating library C:\Users\Joe\Desktop‘SaleaeBnalyzerSdk-1_1_5\MyAnalyzer\Debug\MyAnalyzer lib and object C:\Users\Joe)\Deskt:
1>Embedding manifest...

1>Microseft (R) Windows (R) Resource Compiler Version §.1.6723.1

1>Copyright (C) Micresoft Corporation. A1l rights reserved.

1>Build leg was saved at "file://c:\Users\Joe\Desktop\SalezeAnalyzerSdk-1.1_S\MyAnalyzeriDebugiBuildL:

1>MyRnalyzer - 0 error(s), B8 warningls) B
Build: 1 0 failed, 0 up-to-dste, 0 skipped
‘ -
< n ] »
IE Code Definition Window 231 Call Browser| =] Output (g5 Find Symbol Results |
I recy Lndg Coll chl ns_ |
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8. Note: For 64-bityou needtochange the build targetto the x64 platform. Steps on how to
change to x64: http://msdn.microsoft.com/en-us/library/ms185328(v=vs.90).aspx
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Debugging an Analyzer with Visual Studio

Now let’s debugyourproject. You’'ll need to have the Logicsoftware installed,and typically the same or
higherversion as the SDKyou’re using. We’ll try to maintain binary compatibility in new releases tothe
extent possible, butthere may be occasional breaking changes.

1. Launch the Logic software
a. Options->Preferences
b. Under Searchthis path for AnalyzerPlugins browsetothe Debug (orRelease) folderin

your project.

I (For Developers) Search this path for Analyzer Plugins I

zaefnalyzerSdk-1.1.5\MyAnalyzer\Debug Browse

Save H Cancel ]

c. ClickSave and thenclose the Logicsoftware.
2. Next, we needtotell Visual Studio to use the Logicsoftware inits debug session.

a. InVisual Studio, rightclickinthe Projectitem (under Solution Explorer) and select
Properties.

b. Clickthe Debuggingltem
Under Commandclickinthe field, click the down arrow thatappears, and select
Browse...

d. Navigatetothe Logic.exe program. Thisis typicallylocated at C:\Program Files\Saleae
LLC (Notethatthe older1.0.33 version,ifitisinstalled,islocatedinthe folder
C:\Program Files\Logic—be sure not to accidently use this version).
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MyAnalyzer Property Pages @éj
Configuration: | All Configurations v| Platform: | Active(Win32) v| | Configuration Manager... |
Commaon Properties Debugger to lzunch:
Configuration Properties ||-OCE| Windows Debugger v|
General
Debugging CA\Program Files\5aleae LLC\Logic.exe IZ|
C/C++
’ Command Arguments
Linker

Working Directory
Attach MNo
Debugger Type Auto

Manifest Tool
XML Document Generator

Browse Information -
Environment

Build Events B
Custom Build Step Merge Environment Yes
Command
The debug command to execute.
4 11 3

oK ]| Cancel || Apply

e. PressOK.
3. Debugthe application (F5). Thiswill launchthe Logicsoftware. Ifall has gone well, you should
be able to see youranalyzerinthe analyzers drop down list.

L1

| T1-T2|
¥ Analyzers
CAN
I2C
5/ PCM
1-Wire

Async Serial
SPI
UNL/O

Joe's Protocol

To make sure debuggingis working, put abreakpointinyour Analyzer’s constructor. Then, fromthe
Logic software, selectyouranalyzerfromthe list. Yourbreakpointshouldfire -- you’re off and running!
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Linux

1. Ifyou haven'talready, download and extractthe SaleaeAnalyzerSdk-1.1.x to your desktop, or
otherconvenientlocation.

2. Insidethe SaleaeAnalyzerSdk-1.1.x folder, create anew folder foryour new analyzer project.
Name itsomethinglike MyAnalyzer, SuperSerialAnalyzer, etc.

File Edit View Go Bookmarks Help

B Foward v 4 C AaE Q 1% @ |lonvien v Q
Places v ® | 4| |z build ||& Desktop || SaleaeAnalyzersdk-1.1.5/ | lib|

=i build

i pesktep - - - wd
B file System documentation include lib MyAnalyzer
li=l Network

[ B.0OGBFile... & e H

] compilesh... & J J aviis 5

& Trash source V52008 build_analyzer.py rename_analyzer.py
i@ Documents h

il Music

|| Pictures

I videos

[d Downloads

"MyAnalyzer" selected (containing 0 items)

3. Fromtheroot of SaleaeAnalyzerSdk-1.1.x folder, copy rename_analyzer.py, build_analyzer.py,
and the sourcefolder. Paste these inside your new project folder.
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Pacesy % | 1] abuld | Deskiop | saleacanalyzersdk-1..5) b

= build

@l Desktop 2 2 2 2

! File System
Izl Network
J 8.0GBFile...

= n
1 CompileSh... & i : .

source vs2008 build_analyzer.py rename_analyzer.py

documentation include lib MyAnalyzer

& Trash

i Documents
il Music Y
im] Pictures

I videos

&4 Downloads

1 folder selected (containing 8 items), 2 other items selected (5.5 KB)

File Edit View Go

§@Back v ey ¢ amE Qloo%@l@q

Pecesy %\ bl (B Deskiop | Solesesralzerscb 115, (pynalyzag)

= build

= impa impo
B Desktop i #ind print
dvlib orint

— File System source build_analyzerpy  rename_analyzerpy
Izl Network

J 8.0GBFile...
3 Compilesh...
&, Trash h

> I

i Documents
Il Music

im] Pictures

I videos

&4 Downloads

1 folder selected (containing 8 items), 2 other items selected (5.5 KB)

4, Next, we'll modify the source files so theirnames -- and everythinginthem -- reflect your new
analyzername. Otherwiseit’s a bit of a painto modify by hand.
a. Openaterminal (console)and navigate to your MyAnalyzerfolder. (typically cd
Desktop\SaleaeAnalyzerSdk-1.1.x\MyAnalyzer)
b. Type python rename_analyzer.py
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File Edit View Terminal Help

What would you like to call your new analyzer?

>The files under '/source' will be modified to use it.
>Examples include Serial, MySerial, JoesSerial, Gamecube, Wiimote, 2Wire, etc.
o not inclide the trailing word 'Analyzer' this will be added automaticly.

(press CTRL-C to cancel)

Your new analyzer name: I:l

You will be prompted forthe name of your analyzer—be sure to enterthis without the
Analyzer suffix; this will be added automatically. Forexample, for MyAwesomeAnalyzer,
enter MyAwesome. Also note that this needsto be a valid variable name, soitshould
be one word.

Nextyou will be prompted forthe menutitle todisplay in the Add Analyzer drop down
menuinthe Logic software. Thisisreally easyto change later, so don’tworry about it
too much. For example, you could enter Joe’s Analyzer

@ nalyzerSdk-1.1.5/MyAnalyzer

File Edit View Terminal Help
build@ubuntu-laptop:~/Desktop/SaleaeAnalyzersdk-1.1.5/MyAnalyzers$ python rename |

analyzer.py
What would you like to call your new analyzer?
>The files under '/source' will be modified to use it.
mples include Serial, MySerial, JoesSerial, Gamecube, Wiimote, 2Wire, etc.
o not inclide the trailing word 'Analyzer' this will be added automaticly.

(press CTRL-C to cancel)

Your new analyzer name: My

What is the analyzer's title? (as shown in the add new anlayzer drop down)

xamples include Async Serial, I2C, Joe's Serial, Gamecube, Wiimote, 2Wire, et
(press CTRL-C to cancel)

Your new analyzer's title: Joe's Protocol
build@ubuntu-laptop:~/Desktop/SaleaeAnalyzersdk-1.1.5/MyAnalyzers ||
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e. Thescript should have renamed your projectfilesinyoursource folder, aswell as
changedtheir contents to match your analyzer's name.
5. Lastly, build the analyzer with the build_analyzer build script. Atthe command line, type python
build_analyzer.py

File Edit View Terminal Help

build@ubuntu-laptop:~/Desktop/SaleaeAnalyzersdk-1.1.5/MyAnalyzer$ python build analyzer.py
Running on Linux
g++ -I"../include" -03 -w -c -fpic -o"release/MyAnalyzerSettings.o" "source/MyAnalyzerSettings.cpp"
i -00 -w -c -fpic d ‘MyAnalyzerSettings.o" "source/MyAnalyzerSettings.cpp"
-03 -w -c -fpic elease/MyAnalyzer.o" "source/MyAnalyzer.cpp"
/include" -00 -w -c -fpic -g -o"debug/MyAnalyzer.o" "source/MyAnalyzer.cpp"
/include" -03 -w -c -fpic elease/MyAnalyzerResults.o" "source/MyAnalyzerResults.cpp"
include” -080 -w -c -fpic -g -o"debug/MyAnalyzerResults.o" "source/MyAnalyzerResults.cpp"
-03 -w -c -fpic -o"release/MySimulationDataGenerator.o" "source/MySimulationDataGenera

-08 -w -c -fpic -g -o"debug/MySimulationDataGenerator.o" "source/MySimulationDataGener

./1ib" -lAnalyzer -shared -o"release/libMyAnalyzer.so" release/MyAnalyzerSettings.o release/MyAna
lyzer.o release/MyAnalyzerResults.o release/MySimulationDataGenerator.o
g++ -L"../1ib" -lAnalyzer -shared -o"debug/libMyAnalyzer.so" debug/MyAnalyzerSettings.o debug/MyAnalyzer.
fyAnalyzerResults.o debug imulationDataGenerator.o
build@ubuntu-laptop:~/Desktop/SaleaeAnalyzerSdk-1.1.5/MyAnalyzers D

Next, let’s setup Logicto find your new analyzer

1. Launch the Logic software.
Select Options->Preferences

3. Under Developer, click Browse. Navigate newanalyzer project’s debug (or release) folder, at
SaleaeAnalyzerSdk-1.1.x/ MyAnalyzer/debug

(For Developers) Search this path for Analyzer Plugins

p/SaleaeAnalyzersdk-1.1.5/MyAnalyzer/debug| | Browse |

N

Save Cancel

4. PressSave,andthenclose the Logic software.
5. Launch the Logic software again. Youranalyzershould show upthe Add Analyzer drop-down
list.

¥ Analyzers

Joe's Protocol

Lastly, let’s debug our new analyzer with GDB
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1. Openaterminal (console)
2. Run GDB on the Logic application: type somethinglike gdb
/Home/YourUserName/Desktop/Logic-1.1.x/Logic

File Edit View Terminal Help

build@ubuntu-laptop:~$ gdb Desktop/Logic-1.1.5/Logic

GNU gdb (GDB) 7.1-ubuntu

Copyright (C) 2818 Free Software Foundation, Inc.

License GPLv3+: GNU GPL version 3 or later <http://gnu.org/licenses/gpl.html>
This is free software: you are free to change and redistribute it.

There is NO WARRANTY, to the extent permitted by law. Type "show copying"
and "show warranty" for details.

This GDB was configured as "i486-linux-gnu".

For bug reporting instructions, please see:
<http://www.gnu.org/software/gdb/bugs/>. ..

Readinﬁ symbols from /home/b3ild/Desktop/Logic-1.1.5/Logic...done.

(gdb)

3. Seta breakpointtogetfired whenyouranalyzerisloaded: type break
MyAnalyzer::WorkerThread
a. Becauseyouranalyzerhasn’tbeenloadedyet, GDBwill notify youthatitcan’tfind this
function, and ask if you want to automatically set this breakpointifalibrary witha
matchingfunctionisloadedinthe future. Type y<enter>
Launch the application. Type run
5. Nowselectyouranalyzerfromthe Add Analyzerdrop-down list, and starta collection. GDB
should break execution upon entering your WorkerThread function.

Breakpoint 1, MyAnalyzer::WorkerThread (this=0x8fb617@)
at source/MyAnalyzer.cpp:20

mResults.reset( new MyAnalyzerResults( this, mSettings.get() ) )

Y

6. You can now type step to single step, and continue to resume running.

More in-depth use of GDBis outside the scope of this document.

18
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Build ScriptBased Project

1

Saleae Analyzer SDK 1.1.8

If you haven’talready, download and extract SaleaeAnalyzerSdk-1.1.x to your desktop, or to
anotherconvenientlocation.
Decide onthe name of your project -- MyAnalyzer, SuperSerialAnalyzer, etc. Openthe
SaleaeAnalyzerSdk-1.1.x folderand create a new folderwith this name. We'll call ours

MyAnalyzer

¥ DEVICES
El ipisk
=1 MacMini
|_| NO NAME

¥ PLACES
[ Desktop
ﬁ} Build
ﬁ Applications
@ Documents

¥ SEARCH FOR
@ Today
(L) Yesterday
(£) Past Week
ﬁ All Images
All Movies
All Documents

»

|
-

FYTHON

build_analyzer.py

FYTHON

rename_analyzer.p

v

|| SaleaeAnalyzerSdk-1.1.5

222

include

Al

documentation

— —

source vs2008

MyAnalyzer

3. Selectthe sourcefolder, andthefiles build_analyzer.py and rename_analyzer.py. Copyand
paste these into your new analyzerfolder.

19

¥ DEVICES
El ipisk
=1 MacMini
|_| NO NAME

¥ PLACES
[ Desktop
ﬁ} Build
ﬁ Applications
@ Documents

¥ SEARCH FOR
@ Today
(L) Yesterday
(£) Past Week
ﬁ All Images
All Movies
All Documents

»

rename _analyzer.p

|| SaleaeAnalyzerSdk-1.1.5

222

include

Al

documentation

R —

nrcn- vs2008

—

MyAnalyzer
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80O [_] MyAnalyzer (=)

(o] A=[zl=] [o)[] a )
¥ DEVICES

El iDisk " " 1 z

=4 MacMini

|| NO NAME -

N build_analyzer.py
E Desktop
7 Build
ﬁ Applications
@ Documents

¥ SEARCH FOR
CL) Today
(L) Yesterday
(£) Past Week
ﬁ All Images
(& All Movies
(5] All Documents

4. Openaterminal (underApplications/Utilities) and navigate to your new analyzerfolder. Type
somethinglike cd Desktop\SaleaeAnalyzerSdk-1.1.5\MyAnalyzer

= NoNe Terminal — bash — 809

Last legin: Sat Jan 15 17:11:87 on ttysoed =]
Joes-Mac-Mini:~ Build$ cd Desktop/5aleaeAnalyzerSdk-1.1.5/MyAnalyzer/
Joes-Mac-Mini:MyAnalyzer Build$

5. Nextwe’ll renameand modify the source files so they will be all set up foryouranalyzer. We'll
use the build_analyzer.py scriptto do this.

6. Type python rename_analyzer.py

Copyright 2011 Saleae LLC. All Rights Reserved.



Saleae Analyzer SDK 1.1.8

® MO Terminal — bash — 80x21

Jees-Mac-Mini:MyAnalyzer Build$ python rename_analyzer.py =]

What would you like teo call your new analyzer?

==The files under 'fsource' will be modified to use it.

=>>Examples include Serial, MySerial, JoesSerial, Gamecube, Wiimote, 2Wire, etc.
==Do not inclide the trailing word 'Analyzer' this will be added automaticly.

{press CTRL-C to cancel)

Your new analyzer name: I

kd

7. Followthe prompts

a. You will be prompted forthe name of youranalyzer —be sure to enter this without the
Analyzer suffix; this will be added automatically. Forexample, for MyAwesomeAnalyzer,
enter MyAwesome. Also note that this needs to be a valid variable name, soitshould
be one word.

b. Nextyouwillbe promptedforthe menutitle todisplayinthe Add Analyzer drop down
menuinthe Logic software. Thisisreally easyto change later, so don’tworry about it
too much. For example, you could enter Joe’s Analyzer

c. Thescript should have renamed your projectfilesinyoursource folder, aswell as
changedtheircontentsto match your analyzer's name.

fano Terminal — bash — 80x21

=
What would you like to call your new analyzer?
==The files under 'fsource' will be modified to use 1it.
>>Examples include Serial, MySerial, JoesSerial, Gamecube, Wiimete, 2ZWire, etc.
=>Do not inclide the trailing word 'Analyzer' this will be added automaticly.
{press CTRL-C to cancel)
Your new analyzer name: My
wWhat is the analyzer's title? (as shown in the add new anlayzer drop down)
==Examples include Async Serial, I2C, Joe's Serial, Gamecube, Wiimote, 2Wire, et
C.
(press CTRL-C to cancel)

s
Your new analyzer's title: Joe's Protocol v
Joes-Mac-Mini:MyAnalyzer Build$ I y

8. Nextwe’ll attemptto build the project. Type python build_analyzer.py
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o NeNe) Terminal — bash — 115x20
=]
Joes-Mac-Mini:MyAnalyzer Build$ python build_analyzer.py
Running on Darwin
g++ -I"../include" -03 -w -c -fpic -o"release/MyAnalyzer.o" "source/MyAnalyzer.cpp"
g++ -I"../include" -0@8 -w -c¢ —fpic -g —o"debug/MyAnalyzer.o" "source/MyAnalyzer.cpp"
o++ —I"../include" -03 -w -c¢ -fpic -o"release/MyAnalyzerResults.o" “source/MyAnalyzerResults.cpp”
g++ . " -08 -w —c —fpic -g -o"debug/MyAnalyzerResults. "source/MyAnalyzerResults.cpp"
g+ " 03 -w —c —fpic —o"release/MyAnalyzerSettings.o" "source/MyAnalyzerSettings.cpp"
g++ . " -00 -w -c -fpic -g -o"debug/MyAnalyzerSettings.o" "source/MyAnalyzerSettings.cpp"
g++ -I"../include" -03 -w -c -fpic -o"release/MySimulationDataGenerator.o" "source/MySimulationDataGenerator.cpp"
g++ -I"../include" -0@ -w -c -fpic -g -o"debug/MySimulationDataGenerator.o" "“source/MySimulatienDataGenerator.cpp"
g++ -L"../lib" -lAnalyzer -dynamiclib -o release/libMyAnalyzer.dylib release/MyAnalyzer.o release/MyAnalyzerResults
.0 release/MyAnalyzerSettings.o release/MySimulationDataGenerator.o
g++ -L"../lib" -lAnalyzer -dynamiclib -o debug/libMyAnalyzer.dylib debug/MyAnalyzer.o debug/MyAnalyzerResults.o deb
ug/MyAnalyzerSettings.o debug/MySimulationDataGenerator.o
Joes-Mac-Mini:MyAnalyzer Build$
s
v
A

Your analyzershould now be built. Let’stry to run it from the Logicsoftware.

6. Launch the Logic software.

7. Select Options->Preferences

8. Under Developer, click Browse. Navigate newanalyzer project’s debug (orrelease) folder, at
SaleaeAnalyzerSdk-1.1.x/ MyAnalyzer/debug

{For Developers) Search this path for Analyzer Plugins

eaeAnalyzerSdk-1.1.5/MyAnalyzer/debug [ Browse |

i - \
L Save ) L Cancel 9

9. PressSave,andthen close the Logic software.
10. Launch the Logic software again. Youranalyzershould show up the Add Analyzerdrop-down
list.

¥ Analyzers

Joe's Protocol

Debugging with GDB

7. Openaterminal (underApplications/Utilities)
8. Run GDB on the Logic application: type gdb /Applications/Logic.app/Contents/MacOS/Logic
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® 00 Terminal — bash — 80x24
Last legin: Sat Jan 15 19:29:25 on titys00e =

Joes-Mac-Mini:~ Build$ gdb /Applications/Logic.app/Contents/Mac0S/Logic

GNU gdb 6.3.50-20058815 (Apple wversion gdb-151@) (Wed Sep 22 B2:45:82 UTC 2@18)
Copyright 2004 Free Software Foundation, Inc.

GDE is free software, covered by the GNU General Public License, and you are
welcome to change it and/er distribute copies of it under certain conditicns.
Type "show copying" to see the conditions.

There is absoclutely no warranty for GDE. Type "show warranty" for details.

This GDBE was configured as "xB6_64-apple-darwin'...Reading symbols for shared 1i
Brariés ...ieenssnnnssss done
{gdb) I

P

9. Seta breakpointtogetfiredwhenyouranalyzerisloaded:type break
MyAnalyzer::WorkerThread
a. Becausevyouranalyzerhasn’tbeenloadedyet, GDBwill notify youthatitcan’tfind this
function, and askif you want to automatically set this breakpointif alibrary with a
matchingfunctionisloadedinthe future. Type y<enter>

® MO Terminal — bash — 80x24
Last legin: Sat Jan 15 19:29:25 on ttysooe =2

Joes-Mac-Mini:~ Build$ gdb /Applicaticons/Logic.app/Contents/Mac0S/Logic

GNU gdb 6.3.58-200858815 (Apple wersion gdb-151@) (Wed Sep 22 82:45:82 UTC 2818)
Copyright 2884 Free Software Foundation, Inc.

GDE is free software, covered by the GNU General Public License, and you are
welcome to change it and/or distribute copies of it under certain conditions.
Type "show copying" to see the conditions.

There is absolutely no warranty for GDBE. Type "show warranty" for details.

This GDE was configured as "x86_64-apple-darwin'...Reading symbols for shared 1i
braries ....ceeviennnnas done

{gdb) break MyAnalyzer::WorkerThread

Can't find member of namespace, class, struct, or union named "MyAnalyzer::Worke
rThread"

Hint: try 'MyAnalyzer::WorkerThread=TAB> or 'MyAnalyzer::WorkerThread<=ESC-7=
(Note leading single quote.)

Make breakpoint pending on future shared library load? (y or [n]) vy

Breakpoint 1 (MyAnalyzer::WorkerThread) pending.

{gdb) [l

10. Launch the application. Type run
11. Nowselectyouranalyzerfromthe Add Analyzer drop-down list, and starta collection. GDB
should break execution upon entering your WorkerThread function.
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Breakpeint 1, MyAnalyzer::WorkerThread (this=0x1446eB8) at source/MyAnalyzer.cpp ||
:20

28 mResults, reset( new MyAnalyzerResults( this, mSettings.get() )} ) a
H v

{gdb) y

12. You can now type step to single step, and continue to resume running.

More in-depth use of GDBis outside the scope of thisdocument. Fora GUI based debugging solution,
we recommend using XCode.

XCodebased Project

Note that in this walkthrough we are using XCode on Snow Leopard. Your experience may be somewhat
differentif youareinTiger or Leopard.

1. Start XCode
2. Fromthe File menu, choose New Project
3. ForChoose atemplate foryournew Projectselect Other, Empty Project.

ano New Project

Choose a template for your new project:

L vac os x ( rﬂ ] ri‘

Application

Framework & Library

Application Plug-in Empty Project External Build
System Plug-in System
Other
- Empty Project m

This is an empty project with no files, targets, or build configurations.

(" Cancel ) (Choose...)

v

4. Choose a name foryour analyzer, such as MyAnalyzer, SuperSerialAnalyzer, etc. It should be one
word. Specify thisasthe project’s name.

5. Savethe projectinthe root of the SaleaeAnalyzerSdk-1.1.x folder. This will create afolder called
YourProjectName.

Close XCode. Nextwe’ll getoursource filesinorder.
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1. WithFinder, openthe SaleaeAnalyzerSdk-1.1.x folder. Select the source folder, and the file
rename_analyzer.py, and copy and paste these into your new analyzer project folder.

¥ DEVICES i

E iDisk ”
= MacMini
PYTHON

13

|| NO NAME

¥ PLACES
E Desktop

% Build

ﬁ Applications

[ Documents PYTHON
v

rename_analyzer.p

build_analyzer.py documentation include lib

vs2008 MyAnalyzer

¥ SEARCH FOR
(L) Today
(5) Yesterday
(£) Past Week
All Images
[ All Movies
All Documents

¥ DEVICES
g iDisk d
= MacMini

|_| NO NAME Zi|
¥ PLACES build WAnatyfsjr.xmdep

E Desktop

% Build

fg Applicatiens

@ Documents

13

¥ SEARCH FOR
(L) Today
(L) Yesterday
(£) Past Week
All Images
All Movies
[&] All Decuments

2. Launch Terminal. (Thisis in Application/Utilities)
3. Navigate toyouranalyzerfolderby typing something like cd Desktop/SaleaeAnalyzerSdk-

1.1.x/MyAnalyzer
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(N Né) Terminal — bash — 80x24

Last legin: Sat Jan 15 19:38:48 on ttysoeg =]
Joes-Mac-Mini:~ Build$ cd Desktop/SaleaeAnalyzerSdk-1.1.5/MyAnalyzer/
Jees-Mac-Mini:MyAnalyzer Build$ I

4. Type python rename_analyzer.py and follow the prompts.

® MO Terminal — bash — 80x24

Joes-Mac-Mini:MyAnalyzer Build$ python rename_analyzer.py =]

What would you like to call your new analyzer?

==The files under '/fsource' will be modified to use it.

=>>»Examples include Serial, MySerial, JoesSerial, Gamecube, Wiimote, 2Wire, etc.
==Do not inclide the trailing word 'Analyzer' this will be added automaticly.

{press CTRL-C to cancel)

Your new analyzer name: I

&I

a. You will be prompted forthe name of youranalyzer —be sure to enterthis without the
Analyzer suffix; this will be added automatically. Forexample, for
MyAwesomeAnalyzer, enter MyAwesome. Also note that thisneedstobe avalid
variable name, soitshould be one word.

b. Nextyouwill be promptedforthe menutitle todisplayinthe Add Analyzerdrop down
menuinthe Logic software. Thisisreally easyto change later, so don’tworry about it
too much. For example, you could enter Joe’s Analyzer
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(N Né) Terminal — bash — 80x24

Joes-Mac-Mini:MyAnalyzer Build$ python rename_analyzer.py =]

What would you like to call your new analyzer?

==The files under '/fsource' will be modified to use it.

==Examples include Serial, MySerial, JoesSerial, Gamecube, Wiimote, 2Wire, etc.
=>=>Do not inclide the trailing word 'Analyzer' this will be added automaticly.

{press CTRL-C to cancel)

Your new analyzer name: My

what is the analyzer's title? (as shown in the add new anlayzer drop down)

==Examples include Async Serial, I2C, Jee's Serial, Gamecube, Wiimote, 2Wire, et
c.

{press CTRL-C to cancel)

Your new analyzer's title: Joe's Protocol i
Joes-Mac-Mini:MyAnalyzer Builds I

kd

c. Thescript should have renamed your projectfilesinyoursource folder, aswell as
changedtheircontentsto match your analyzer's name.

(o NN ) Terminal — bash — 88x22

Joez-Mac-Mini :Mydnolyzer Joed python renome_onalvzer.pw B

What would wou like to call your new analyzer?

=The files under 'Ysource' will be modified to use it.

==Exomples include Serial, MySerial, JoesSeriaol, Gamecube, Wiimote, 2Wire, etc.
Do not inclide the trailing word ‘Analyzer' this will be added automaticly.

{press CTREL-C to concel)

Your new analyzer nome: My

What is the analyzer's title? (os shown in the add new onlayzer drop down)

==Exomples include Async Serial, I2C, Joe's Serial, Gamecube, Wiimote, ZWire, etc.

{press CTRL-C to cancel)

Your new analvzer's title: my cool protocol
Joez-Mac-Mini :Myanalyzer Joed I

R e |

Back to XCode

1. Inyournew projectfolder, double-click the XCode project. (starting XCode)
2. Under Groups & Files, right-click on Targets, and select Add->New Target
3. SelectBCD, DynamicLlibrary template, and click Next.

27 Copyright 2011 Saleae LLC. All Rights Reserved.



Saleae Analyzer SDK 1.1.8

Choose a template for your new target:

ﬂ Mac OS5 X - ;
ey @ W G
Application Plug-in = v

Dynamic Library Object File

Shell Tool Static Library
System Plug-in

Other

Dynamic Library

¢

BN — )

Targer for building a dynamic library that uses BSD APIs.

Cancel

(" previous ) E Next 3
A
e

4. ForTarget Name, enteryouranalyzer’sname (MyAnalyzerforexample). Click Finish.

e~ NewTarge

New Dynamic Library

Target Name: leAn alyzerl

Add To Project: [ MyAnalyzer

Cancel

(Previous ) G—ﬁllll!h-a

Y
e

This will openthe TargetInfo window. Close this.

In the Groups & Files list, select the projectitem atthe very top of the list. Rightclickand select
Add->Existing Files.

Navigate to yoursource folderand selectall the files, including the headers. Click Add.
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[a»] (22 EI—EEE-i ['[] source

2 CY

¥ DEVICES
El iDisk
= MacMini
|_| NO NAME
¥ PLACES
[ Desktop
4} Build
ﬁ Applications
@ Documents

¥ SEARCH FOR
(L) Today
(L) Yesterday
(L) Past Week
(] All Images

3

| build_analyzer.py
[ documentation

[ include

£ lib

[ MyAnalyzer

' rename_analyzer.py
[ source

[ vs2008

2 build S
| MyAnalyzer.xcodeproj
| rename_analyzer.py
[ source S

B mMyaAnalyzer.cpp

r.h

[H MyAnalyzerSettings.h
S B MySimula.._rator.cpp
[ [@ MySimula._nerator.h

New Folder

(CGaneel) (Cda)

8. Thedefaultsshould be fine. Click Add.

[ | Copy items into destination group’s folder (if needed)

Reference Type: f Default

Text Encoding: [ Unicode (UTF-8)

)_ﬂ

k

)_H

*) Recursively create groups for any added folders
() Create Folder References for any added folders

Add To Targets

® g MyAnalyzer

(_Can{el :I E—A:H-}

£

9. Selectthe projectitem (atthe top of thelist), and click the Info button on the maintoolbar.
a. Clickthe Build tab.

b. SetConfigurationtoAll Configurations, and set Show to All Settings

8.6
(s
Configuration: [ All Configurations I-H (
show: [ All Settings 1
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c. Scrolldownto Search Paths section
d. ForHeaderSearch Paths, enter..f/include

[ JeNe! Proiect “M;Anmzer" Info

[ General | Build | Configurations =~ Comments

Configuration: | All Configurations % (@~ search in Build settings
Show: | All Settings B‘

Settin Value
TS L FIEgTUCEsSUT FIena rie

Preprocess Info.plist File
Preserve HF5 Data
Private Headers Folder Path
Product Name
Property List Output Encoding same-as-input
Public Headers Folder Path
Strings file Output Encoding UTF-16
Wrapper Extension

¥S5earch Paths m
Always Search User Paths ]
Framework Search Paths

| Header SearchPaths | jincude |
Library Search Paths
Rez Search Paths
Sub-Directories to Exclude in Recursive 5. *.nib *.lproj *.framework *.gch *xcode* {*) CVS .svn .git
Sub-Directories to Include in Recursive Se...
User Header Search Paths

¥Unit Testing

Other Test Flags t

1

oo

This is a list of paths to folders to be searched by the compiler for included or imported header files when compiling C, Objective-C, C++, or
Objective-C++. Paths are delimited by whitespace, so any paths with spaces in them need to be properly quoted
[HEADER_SEARCH_PATHS, -I]

Based On: | Nothing v ®
G

e. Closethe Projectinfowindow.
10. Expandthe Targets itemuntil you see the Link Binary With Libraries item.

- |
Groups & Files Il

v B MyAnalyzer B
E MyAnalyzer.cpp
E MyAnalyzer.h
E MyAnalyzerResults.cpp
E MyAnalyzerResults.h
E MyAnalyzersettings.cpp
E MyAnalyzersettings.h
E MySimulationDataGenerator.cpp
E MySimulationDataGenerator.h
» [ ] Products
7@ Targets
W g MyAnalyzer
b [ ] Copy Headers (4}
b [ ] Compile Sources (4}
¥ W Link Binary With Libraries

[ L -

a. Rightclickon Link Binary With Libraries and select Add->Existing Files.
b. Navigatetoand selectlibAnalyzer.dylib fromlib folderinthe SaleaeAnalyzerSdk-1.1.x

folder.
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IR

@) (G B @

¥ DEVICES | build_analyzer.py | Analyzer.dIl
Il iDisk (1] documentation ~ @ Analyzer.lib
= MacMini [ include > i libAnalyzer.dylib
D NO NAME a (] lib g EPI readme.txt
[ MyAnalyzer s
¥ PLACES |9 rename_analyzer.py
B Deskrop (] source 3
& Build [ vs2008 3
ﬁ Applications
@ Documents
¥ SEARCH FOR
(L) Today
(L) Yesterday
(L) Past Week M / ]
(] All Images 7 [ <>l
Ccanee) a0

A

c. ClickAdd, and exceptthe defaults by click Add again.

8n0o MyAnalyzer =

Qr String Matching

Groups & Files |Role % Code (] A
v [ MyAnalyzer /B = libAnalyzer.dylib Required
= libAnalyzer.dylib
@ MyAnalyzer.cpp
MyAnalyzer.h
B MyAnalyzerResults.cpp
@ MyAnalyzerResults.h
Ia MyAnalyzerSettings.cpp
@ MyAnalyzerSettings.h
B MySimulationDataGenerator.
MySimulationDataGenerator.
» [ ] Products
V@ Targets
Y& MyAnalyzer la
» [ Copy Headers (4)
» [ ] Compile Sources (4)
¥ [ Link Binary With Libraries

No Editor

b <4 Executables
¥ (2 Find Results
[l Bookmarks
=
- Project Symbols
¥ [ Implementation Files
» {3 Interface Builder Files

Build failed (71 errors, 1 warning) DFailed 41 71

From the Build menu (atthe top of the screen), select Build. Your project should build completely.
Running & Debugging your Analyzer
1. Launch the Logic software.

31 Copyright 2011 Saleae LLC. All Rights Reserved.



Saleae Analyzer SDK 1.1.8

a. SelectOptions->Preferences

Under Developer, click Browse. Navigate newanalyzer project’s debug (or release)
folder, at SaleaeAnalyzerSdk-1.1.x/ MyAnalyzer/build/debug

OB Select path to search for analyzer plugins on startup
(<% (5= hm) (E@Debug B Q
DEVICES m build_analyzer.py [ build 2 ™ Debug > hMyAnalyzer.dylib
E iDisk ||| £ documentation MyAnalyze odepro, [ myAnalyzer.build
= T | || £2 include ename_a
| NO NAME a |l & lib ] source
= | 2 MyAnalyzer S
PLACES | rename_analyzer.py
% |Desktop ! 3 source
Y Build ! £ vs2008
/A Applications :

J/ Documents |

SEARCH FOR

(L) Today v

(L) Yesterday

(L) Past Week . 1 1 it "

(3] Al Images v _ -
JP—

{ New Folder ) ( Cancel ) Choose

) .

c. PressSave,andthenclose the Logic software.

Launch the Logic software again. Youranalyzershould show upthe Add Analyzerdrop-
downllist.

* Analyzers

Joe's Protocol

2. Bringup youranalyzerprojectin XCode
a. Rightclickon the Executablesitem, and select Add->New Custom Executable.
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Q- String Matching

Groups & Files
¥ 8 MyAnalyzer =
* libAnalyzer.dylib
Ia MyAnalyzer.cpp
@ MyAnalyzer.h
@ MyAnalyzerResults.cpp
@ MyAnalyzerResults.h
@ MyAnalyzerSettings.cpp
@ MyAnalyzersetings.h
Ia MySimulationDataGenerator.
@ MySimulationDataGenerator.
» [ ] Products

-
(b = c. ¢ ® |

A No Editor

» [l Bookmarks
»Edscm

- Project Symbols
¥ [ Implementation Files
¥ [ Interface Builder Files

i. Executable Name: Logic

ii. Executable Path: /Applications/Logic.app (orsimilar)
iii. Click Finish.

Executable Name: ILogic I
Executable Path: |;App|icati{ms!Logic.app |
Add To Project: [ MyAnalyzer ~

(Previous ) (—Frmh—}

V4

b. From XCode, openthe primary cpp file (MyAnalyzer.cpp orsimilar).
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¢. Godownto thefirstline on WorkerThread and click inthe marginto create a
breakpoint.

d. Fromthe Build menu, select Build and Debug.
Selectyournew analyzerfrom the Add Analyzer drop-down.

Start a data collection. XCode should break execution at your breakpoint.

eno le) MyAnalyzer.cpp =

i

. g L
[ e
Thread-9 2 ° » o ¥ T @ i MyAnalyzer:WorkerThread
<  |d MyAnalyzer.cpp:l +  <No selected symbol> % L | O | | -

i =]

SetAnalyzerSettings({ mSettings.getl) ); ey
¥
Myhnalyzer: i~MyAnalyzer() [
i

KillThread();
void MyhAnalyzer:iWorkerThread()
i

[ g mResults.reset( new MyfAnalyzerResults( this, mSettings.get(] ] };

SetAnalyzerResults{ mResults.get(]) };
mResults—=AddChannelBubblesWillAppearOn{ mSettings-=nInputChannel };

mtamp LeRateHz = GetSampleRate();
mserial = GetAnalyzerChannelData{ mSettings-=mInputChannel };

if{ mESerial-=GetBitState() == BIT_LOW )

I meerial-sAdvanceToNextEdoge(); . b
|'l=l=IFil=I=IFil:l:l:lﬂﬂl:l:l:l&lﬁii:ll YAl

CDB: Stopped at breakpoint 1 (hit count : 1) - 'MyAnalyzer:WorkerThread{) - Line 20° @ Succeeded A

alw(
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Writing your Analyzer’s Code
This second part of the document deals with writing the code foryouranalyzer.

There are 4 c++ filesand 4 headerfiles thatyou will implement to create youranalyzer. If you followed
the procedure in the first part, you already have a working analyzer, and will be modifying th at code to
suityour needs.

Conceptually,the analyzercan be brokeninto 4 main parts — the 4 c++ files. Workingonthemina
particularorderis highly recommended, and this document describes the procedurein this order.

Firstyou’ll work on the AnalyzerSettings-derived class. You'll definethe settings youranalyzerneeds,
and create interfaces that’ll allow the Logicsoftware to display a GUI for the settings. You'll also
implement serialization forthese settings sothey can be saved and recalled from disk.

Nextyouimplementthe SimulationDataGenerator class. Here you’ll generate simulated datathat can be
laterto testyour analyzer, or provide an example of what youranalyzer expects.

Third you’ll create your AnalyzerResults-derived class. Thisclasstranslates saved resultsintotextfora
variety of uses. Here you’ll startthinking about the formatyour results will be savedin. You probably
will revisit your this file afterimplementing your Analyzer.

Lastly, you’llimplement your Analyzer-derived class. The mainthingyou’ll do here istranslate data
streamsintoresults, based onyour protocol.

Let’s get started!

35 Copyright 2011 Saleae LLC. All Rights Reserved.



Saleae Analyzer SDK 1.1.8

Analyzer Settings

Aftersetting up youranalyzer project, and renamingthe source files to match your project, the first step
isto implement/modify youranalyzer’s AnalyzerSettings-derived class.

{YourName}AnalyzerSettings.h

In thisfile, you provide adeclaration foryour {YourName}AnalyzerSettings class. This class mustinherit
from AnalyzerSettings, and should include the AnalyzerSettings.h headerfile.

We'll start with this

#ifndef SIMPLESERIAL ANALYZER SETTINGS

#define SIMPLESERIAL ANALYZER SETTINGS

#include <AnalyzerSettings.h>

#include <AnalyzerTypes.h>

class SimpleSerialAnalyzerSettings : public AnalyzerSettings
{
public:

SimpleSerialAnalyzerSettings () ;

virtual ~SimpleSerialAnalyzerSettings();

virtual bool SetSettingsFromInterfaces () ;

void UpdateInterfacesFromSettings () ;

virtual void LoadSettings ( const char* settings );
virtual const char* SaveSettings();

}i

#endif //SIMPLESERIAL ANALYZER SETTINGS

In addition, your header will definetwo sets of variables:

User-modifiable settings

This will alwaysinclude at least one variable of the type Channel—so the user can specify whichinput
channeltouse. Thiscannot be hard coded, and must be exposed as a setting. (Channelisn’tjustan
index, italso specifies which Logicdevice the channel isfrom). Other possible settings depend on your
protocol, and mightinclude:

e Bitrate
e Bitspertransfer
e Bit ordering (MSb first, LSb first)

e Clockedge (rising, falling)to use
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e Enableline polarity
e Etc —anythingyouneedforyourspecificprotocol. If youlike, start with justthe Channel
variable(s), and you can add more laterto make youranalyzer more flexible.

The variable types can be whateveryou like —std::string, double, int, enum, etc. Note thatthese
variables will need to be serialized (saved forlater, toafile) sowhenin doubt, stick to simple ty pes
(ratherthan custom classes or structs). The SDK providesameansto serializeand store yourvariables.

AnalyzerSettingsInterfaces

One of the servicesthe Analyzer SDK providesisameans for users to edityoursettings, witha GUI, with
minimal work on your part. To make this possible, each of yoursettings variables must have a
correspondinginterface object. Here are the avalible AnalyzerSettingsinterface types:

e AnalyzerSettingInterfaceChannel: Used exclusivly forinput channel selection.

CAN 0-'Channeld’ =

o AnalyzerSettingInterfaceNumberList: Used to provide alist of numerical options forthe userto
choose from. Note that this can be used to select from several enumtypes as well, asillustrated
below. (Each dropdown below isimplemented with its own interface object)

|E Bits per Transfer (Standard) - |

|1 Stop Bit (Standard) ~ |

| No Parity Bit (Standard) ~ |

| Least Significant Bit Sent First (Standard) -

|Non Inverted (Standard] - |

e AnalyzerSettingInterfacelnteger: Allows a userto type an integerinto a box.

EBit Rate (Bits/5) 9600

e AnalyzerSettingInterfaceText: Allows a userto enter some textinto a textbox.
e AnalyzerSettingInterfaceBool: Provides the userwith a checkbox.

Use Autobaud
AnalyzerSettingsinterface types should be declared as pointers. (We're usingthe std::auto_ptrtype,

which largly acts like astandard (raw) pointer. It’s a simple form of what’s called a “smart pointer” and it
automaticly calls delete on its contents when it goes out of scope.)
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{YourName}AnalyzerSettings.cpp

The Constructor

In your constructor, we’ll firstinitilize all your settings variables to their default vaules. Second, we’ll
setup eachvariable’s correspondinginterface object.

Note that if the userhas previously entered values for this analyzer, these willbe loaded at alatertime.
Be sure to initialize the variables to values that you want to be defaults. These will show up whenauser
adds a new instance of youranalyzer.

Setting up each AnalyzerSettingInterface object

First, we create the object (call new) and assign the value to the interface’s pointer. Note thatwe’re
using std::auto_ptr, sothis means callingthe memberfunction reset. Forstandard (raw pointers), you
would dosomethinglike:

mInputChannelInterface = new AnalyzerSettingInterfaceChannel ();

Next, we call the memberfunction SetTitleAndTooltip. The title will appearto the left of the input
element. Note that oftentimes youwon’t need atitle, but you should use one for Channels. The tooltip
shows upwhen hoveringoverthe inputelement.

void SetTitleAndTooltip ( const char* title, const char* tooltip );

mInputChannelInterface->SetTitleAndTooltip( "Serial", "Standard Async Serial" );

We'll want to setthe value. Theinterface objectis, well, aninterface to our settings variables. When
settingup the interface, we copy the value from our settings variable tothe interface. Whenthe user
makes a change, we copy the value inthe interface to our settings variable. The function namesforthis
differdependingonthe type of interface.

void SetChannel( const Channelé& channel );
void SetNumber ( double number );

void SetInteger( int integer );

voilid SetText( const char* text );

void SetValue ( bool value );

We'll want to specify the allowable options. This depends on the type of interface.

AnalyzerSettingInterfaceChannel

void SetSelectionOfNoneIsAllowed( bool is allowed );

Some channels can be optional, but typically they are not. By default, the usermustselectachannel.

AnalyzerSettingInterfaceNumberList

void AddNumber ( double number, const char* str, const char* tooltip );
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Call AddNumberforeveryitemyouwantinthe dropdown. numberisthe value assiciated with the
selection;itisnotdisplayedtothe user.

AnalyzerSettingInterfacelnteger

void SetMax ( int max );

void SetMin ( int min );
You can setthe allowablerange forthe integerthe usercan enter.

AnalyzerSettingInterface Text

void SetTextType ( TextType text type );

By default, thisinterface just provides asimple textbox for the userto entertext, butyoucan also
specify thatthe textshould be a path, which will cause abrowse buttonto appear. The optionsare
NormalText, FilePath, or FolderPath.

AnalyzerSettingInterfaceBool
There are only two allowable optionsforthe bool interface (checkbox).

Aftercreating ourinterfaces (with new), givingthem atitles, settings theirvalues, and specifying their
allowed options, we need to expose them to the API. We do that with function AddInterface.

void AddInterface( AnalyzerSettingInterface* analyzer setting interface );
Specifing the export options

Analyzers can offermore than one exporttype. Forexample txtorcsv, or even a wav file or bitmap. If
these need special settings, they can be specified as analyzervariables/interfaces aswe’ve discussed.

Exportoptionsare assignedan ID. Later, whenyourfunctionforgeneratingexportdataiscalled, thisID
will be provided. There are two functions you’ll need to call to specfiy an exporttype. Be sure to specify
at least one export type (tyically text/csv).

void AddExportOption( U32 user id, const char* menu text );

void AddExportExtension( U32 user id, const char * extension description, const char *
extension );

AddExportOption( 0, "Export as text/csv file" );
AddExportExtension ( 0, "text", "txt" );

AddExportExtension( 0, "csv'", "csv" );

Specifying which channels are in use

The analyzer mustindicate which channel(s) itis using. Thisis done withthe AddChannelfunction.
Every time the channel changes (such as when the user changesthe channel) the reported channel must
be updated. To clearany previous channelsthat have been set, call ClearChannels.

void ClearChannels () ;
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void AddChannel ( Channelé& channel, const char* channel label, bool is used );
ClearChannels () ;

AddChannel ( mInputChannel, "Serial", false );

Note that inthe constructor, we have set is_usedto false. Thisis because by defualtourchannelisset
to UNDEFINED_CHANNEL. Afterthe userhas setthe channel to something otherthatn

UNDEFINED CHANNEL, we would specify true. It would always be true, unless the channelwas optional,
inwhich case you will need to examine the channel value, and specify false if the channel is set to
UNDEFINED_CHANNEL. We'lldiscuss this lateras it comesup.

The Destructor

Generallyyouwon’t need todoanythinginyour AnalyzerSettings-derived class’s destructor. However,
if you are using standard (raw) pointers foryoursettingsinterfaces, you’ll need to delete them here.

bool {YourName}AnalyzerSettings::SetSettingsFromInterfaces()

As the name implies, in this function we will copy the values savedin ourinterface objects to our
settingsvariables. Thisfunction will be called if the userupdates the settings.

We can also examine the values saved in the interface (the user’s selections) and choose to reject
combinationswe don’twanttoallow. Ifyouwant to rejecta particularselection, do notassignthe
valuesinthe interfacestoyoursettings variables —use temporary variables so you can choose notto
assignthem at the last moment. Torejecta user’sselections, return false; otherwise return true. If you
returnfalse (rejectthe user’s settings), you also need to call SetErrorTextto indicate why. This will be
presentedtothe userina popupdialog.

void SetErrorText( const char* error text );

For example, when using more than one channel, you would typically want to make sure that all the
channels are different. You can use the AnalyzerHelpers::DoChannelsOverlap function to make that

easierifyoulike.

For youranalyzer, it’s quite possible that all possible userselections are valid. Inthat case youcan
ignore the above.

Afterassigning the interfacevalues to yoursettings variables, you also need to update the channel(s)
the analyzerwill reportas beingused. Below is an example from SimpleSerialAnalyzerSettings.

bool SimpleSerialAnalyzerSettings::SetSettingsFromInterfaces ()

{
mInputChannel = mInputChannelInterface->GetChannel ();

mBitRate = mBitRateInterface->GetInteger ();

ClearChannels () ;

AddChannel ( mInputChannel, "Simple Serial", true );
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return true;

}

void {YourName}AnalyzerSettings::UpdatelnterfacesFromSettings()

UpdatelnterfacesFromSettings goesin the opposite direction. Inthis function, update all yourinterfaces
with the values fromyoursettings variables. Below isan examplefrom SimpleSerialAnalyzerSettings.

void SimpleSerialAnalyzerSettings::UpdatelnterfacesFromSettings ()
{
mInputChannel Interface->SetChannel ( mInputChannel );
mBitRateInterface->SetInteger( mBitRate );

}

void {YourName}AnalyzerSettings::LoadSettings( constchar*settings )

In the last to functions of your AnalyzerSettings-derived class, you’llimplement serialization
(persistence) of yoursettings. It’s pretty straightforward.

Your settings are savedin, and loaded from, a single string. You can technically serialize all of your
variablesinto astringanywayyoulike, including third partlibraries like boost, but to keep things simple
we provided amechanismto serialize yourvariables. We'll discuss that here.

First,you’ll need a SimpleArchive object. This will perform serialization forus. Use SetString to provide
the archive with our settings string. This stringis passedinasa parameterto LoadSettings.

class LOGICAPI SimpleArchive
{
public:

SimpleArchive () ;

~SimpleArchive() ;

void SetString( const char* archive string );

const char* GetString() ;

bool operator<<( U64 data );

bool operator<<( U32 data );

bool operator<<( S64 data );

bool operator<<( S32 data );

bool operator<<( double data );

bool operator<<( bool data )

bool operator<<( const char* data );

bool operator<<( Channel& data );

bool operator>>( U64& data ) ;
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bool operator>>( U32& data );

bool operator>>( S64& data );

bool operator>>( S32& data );

bool operator>>( double& data );

bool operator>>( bool& data );

bool operator>>( char const ** data );

bool operator>>( Channel& data );

protected:
struct SimpleArchiveData* mData;

i

Nextwe will use the archive to loaf all of our settings variables, usingthe overloaded >>operator. This
operatorreturns bool— it will return falseif the requested type is not exactlyinthe right place in the
archive. Thiscould happenif you change the settings variables overtime, and a usertriestoload an old
settings string. If loadingfails, you can simply not update that settings variable (it will retain its default
value).

Since our channel values may have changed, we willalso need to update the channels we’re reporting as
using. We needto do this every times settings change.

Lastly, call UpdatelnterfacesFromSettings. This will update all ourinterfacesto reflectthe newly loaded
values.
Below isan example from SimpleSerialAnalzerSettings.

void SimpleSerialAnalyzerSettings::LoadSettings( const char* settings )

{
SimpleArchive text archive;

text archive.SetString( settings );

text archive >> mInputChannel;

text archive >> mBitRate;

ClearChannels () ;

AddChannel ( mInputChannel, "Simple Serial", true );

UpdateInterfacesFromSettings () ;
}

constchar*{YourName}AnalyzerSettings::SaveSettings()

Our last function will save all of oursettings variablesinto asingle string. We’lluse SimpleArchive to
serialize them.
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The order in which we serialize our settings variables must be e xactly the same order as we extract
them, in LoadSettings.

When returning, use the SetReturnString function, as this will provide a pointerto a string that will not
go out of scope when the function ends.

Bellow isan example from SimpleSerialAnalyzerSettings:

const char* SimpleSerialAnalyzerSettings::SaveSettings()
{

SimpleArchive text archive;

text archive << mInputChannel;

text archive << mBitRate;

return SetReturnString( text archive.GetString() );
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SimulationDataGenerator

The next step aftercreatingyour {YourName}AnalyzerSettings files, is to create your
SimulationDataGenerator.

Your SimulationDataGenerator class provides simulated data so that you can testyour analyzer against
controlled, predictable waveforms. Generally you should make the simulated data match the user
settings, soyou can easily testunderavariety of expected conditions. Inaddition, simulated data gives
end usersan example of whatto expectwhen usingyouranalyzer, as well as examples of what the
waveforms should look like.

That said, fullyimplementing simulated datais not absolutely required to make an analyzer.

{YourName}SimulationDataGenerator.h

Besidesthe constructorand destructor, there are only two required functions, and two required
variables. Otherfunctionsand variablescanbe added, to helpimplementyoursimulated data. Here is
an example starting point, from SimpleSerialSimulationDataGenerator.h

#ifndef SIMPLESERIAL SIMULATION DATA GENERATOR

#define SIMPLESERIAL SIMULATION DATA GENERATOR

#include <SimulationChannelDescriptor.h>

class SimpleSerialAnalyzerSettings;

class SimpleSerialSimulationDataGenerator

{

public:
SimpleSerialSimulationDataGenerator ();

~SimpleSerialSimulationDataGenerator() ;

void Initialize( U32 simulation sample rate, SimpleSerialAnalyzerSettings*
settings );

U32 GenerateSimulationData( U64 newest sample requested, U32 sample rate,
SimulationChannelDescriptor** simulation channel ) ;

protected:
SimpleSerialAnalyzerSettings* mSettings;
U32 mSimulationSampleRateHz;
SimulationChannelDescriptor mSerialSimulationData;
}i
#endif //SIMPLESERIAL SIMULATION DATA GENERATOR
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Overview

The key to the SimulationDataGeneratoris the class SimulationChannelDescriptor. Youwill need one of
these forevery channel you will be simulated (serial, forexample, only needs to simulateon one
channel). Whenyour GenerateSimulationData function is called, your job will be to generate additional
simulated data, up to the amountrequested. When complete, you provide the callerwith apointerto
an array of your SimulationChannelDescriptor objects.

We’ll go overthisin detail inaminute.
{YourName}SimulationDataGenerator.cpp

Constructor/Destructor

You may or may not need anythinginyour constructor or destructor. For now at least, leave them
empty. Atthetime we’re constructed, we really have noideawhatthe settings are oranythingelse, so
there’s not much we can do at this point.

void {YourName}SimulationDataGenerator::Initialize( U32 simulation_sample_rate,
{YourName}AnalyzerSettings* settings )

This function provides you with the state of things as they are goingto be when we start simulating.
We'll needto save thisinformation.

First, save simulation_sample_rate and settings to membervariables. Notice that we now have a
pointertoour AnalyzerSettings-derived class. Thisis good, now we know what all the settings will be for
our simulation—which channel(s)it will be on, aswell as any other settings we might need —like if the
signalisinverted, etc.

Next, we’ll wanttoinitialize the state of our SimulationChannelDescriptor objects—we need to set what
channelit’sfor, the sample rate, and the initial bit state (high orlow).

At this pointwe’ll need to take a step back and discuss some key concepts.
BitState

BitState is a type used ofteninthe SDK. It can be either BIT_LOW or BIT_HIGH, and representsa
channel’s logicstate.

Sample Rate (samples per second)

Sample Rate refersto how many samples persecond the datais. Typicallyitreferstohowfastwe’re
collecting data, but forsimulation, it refersto how fast we’re generating sample data.
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Sample Number

Thisis the absolute sample number, starting at sample 0. When a data collection starts, the first sample
collectedis Sample NumberQ. The nextsample collectedis Sample Number 1, etc. Thisis thesamein
simulation. The first sample we’ll provide is Sample Number0, and so on.

SimulationChannelDescriptor

We needthisobjecttodescribe asingle channel of data, and whatits waveformlooks like. We do this
ina verysimple way:

e We provide the initial state of the channel (BIT_LOW, or BIT_HIGH)
e We move forward some number of samples, and then toggle the channel.
o We repeatedlydothis

The initial bit state of the channel neverchanges. The state (high orlow) of a particularsample number
can be determined by knowing how many timesit has toggled up to that point (an even or odd number
of times).

Put anotherway:

e Intheverybeginning, we specify the initial state (BIT_LOW orBIT_HIGH). This is the state of
Sample NumberO.

e Then, we move forward (advance) some number of samples. 20 samples, forexample.

e Then, we toggle the channel (low becomes high, highbecomes low).

e Thenwe move forward (advance) some more. Maybe 100 samples thistime.

e Thenwe toggle again.

e Thenwe move forward again, and then we toggle again, etc.

Let’s explore the functions used to do this:

void Advance( U32 num_samples_to_advance );

As you might guess, thisis how we move forward in our simulated waveform. Internally, the object
keepstrack of whatits Sample Numberis. The Sample Numberstarts at0. Aftercalling Advance( 10) x3
times, the Sample Number will be 30.

void Transition();

Thistogglesthe channel. BIT LOWbecomes BIT _HIGH, BIT_HIGH becomes BIT LOW.The current
Sample Numberwillbecome the new BitState (BIT_LOW orBIT_HIGH), and all samples afterthat will
also be the new BitState, untill we toggle again.
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void TransitionlfNeeded( BitState bit_state );

Often we don’twantto keep track of the current BitState, which toggles every time we call Transition.
TransitionlfNeeded checks the current BitState, and only transitions if the current BitState doesn’t match
the one we provide. Inotherwords “Change to this bit_state, if we’re not already”.

BitState GetCurrentBitState();

This function lets you directly ask what the current BitState is.
U64 GetCurrentSampleNumber();

Thisfunction lets you ask what the current SampleNumber is.

ClockGenerator

A commonissue with converting exacttiming values into numbers-of-samples, is that you lose some
precision. Thisisn’talwaysaproblem, butit’s nice to have a way to keep track of how much error is
buildingup, and then, just atthe righttimes, add an extrasampleinsothat on average, the timingis
exact.

ClockGeneratoris a class providedin AnalyzerHelpers.hwhich will let you enter time values, rather than
numbers-of-samples. Forexample, instead of figuring out how many samples are in 500ns, you can just
use ClockGeneratorto both figure it out and manage the error, so thaton average, yourtimingis
perfect.

Initially we created ClockGeneratorto create clock-like signals, but now you can use and time value, any
time. Here’s how:

void Init( double target_frequency, U32 sample_rate_hz );

You’ll need to call this before using the class. For sample_rate_hz, enterthe sample rate we'll be
generatingdataat. For target_frequency, enterthe frequency (in hz) you willmost commonly be using.
For example, the bitrate of a SPI clock, etc.

U32 AdvanceByHalfPeriod( double multiple = 1.0 );

This function returns how many samples are needed to move forward by one half of the period (for
example, the low time fora perfect square wave). You can also entera multiple. Forexaple, togetthe
number of samplesto move forward fora full period, enter 2.0.

U32 AdvanceByTimeS( double time_s );

This functions provides number of samples needed to advance by the arbitrary time, time_s. Note that
thisisin seconds, so enter 1E-6 for for one microsecond, etc.
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Note that the number of samplesfora specifictime period may change slightly every once inawhile.
Thisis so thaton average, timing will be exact.

You may wantto have a ClockGeneratoras a memberof you class. This makesit easyto use fromany
helperfunctions you might create.

void {YourName}SimulationDataGenerator::Initialize( U32 simulation_sample_rate,
{YourName}AnalyzerSettings* settings )

Let’s take anotherlook at the Initialize function, now that we have an ideawhat’s going on. This
exampleisfrom SimpleSerialSimulationDataGenerator.cpp.
void SimpleSerialSimulationDataGenerator::Initialize( U32 simulation sample rate,
SimpleSerialAnalyzerSettings* settings )

{
mSimulationSampleRateHz = simulation sample rate;

mSettings = settings;

mSerialSimulationData.SetChannel ( mSettings->mInputChannel );
mSerialSimulationData.SetSampleRate ( simulation sample rate );
mSerialSimulationData.SetInitialBitState ( BIT HIGH );

}

U32 {YourName}SimulationDataGenerator::GenerateSimulationData( U64
largest_sample_requested, U32 sample_rate, SimulationChannelDescriptor** simulation_channel )

Thisfunctionis repeatedly called to request more simulated data. Whenit’s call ed, just keep going
where you left off. Inaddition, you can generate more datathat requested, to make things easy -- that
way you don’t have to stop half way in the middle of something and try to pickit back up later exactly
where you left off.

When we leave the function, our Sample Number —in our SimulationChannelDecriptor object(s) must be
equaltoor largerthan largest_sample_requested. Actually, thisnumberneedstofirst be adjusted (for
technical reasons related to future compatibility). Use the helperfunction
AdjustSimulationTargetSample to do this, as we’ll see inamoment.

The parameter simulation_channels is to provide the caller with a pointerto an array of your
SimulationChannelDecriptor objects. We’ll setthis pointeratthe end of the function. The returnvalue
isthe numberof elementsin the array — the number of channels.

The primary task of the functionis to generate the simulation data, which we typicallydoinaloop —
checking until we have generated enough data. Acleanway of doingthisisto generate acomplete
piece (possibly afull transaction) of your protocol ina helperfunction. Then just repeatedly call this
function until enough data has been generated. You can also add spacing between the elements of your
protocol as you like.
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Here is an example from SimpleSerialSimulationDataGenerator.cpp. We're going to be outputting chars

froma string, which we initialized in our constructor as shown.

SimpleSerialSimulationDataGenerator::SimpleSerialSimulationDataGenerator ()
mSerialText ( "My first analyzer, woo hoo!" ),
mStringIndex( 0 )

{

}

U32 SimpleSerialSimulationDataGenerator: :GenerateSimulationData ( U64
largest sample requested, U32 sample rate, SimulationChannelDescriptor**
simulation channel )

{

U64 adjusted largest sample requested =
AnalyzerHelpers: :AdjustSimulationTargetSample ( largest sample requested, sample rate,
mSimulationSampleRateHz ) ;

while( mSerialSimulationData.GetCurrentSampleNumber () <
adjusted largest sample requested )

{
CreateSerialByte () ;

*simulation channel = &mSerialSimulationData;

return 1;

void SimpleSerialSimulationDataGenerator::CreateSerialByte ()

{
U32 samples per bit = mSimulationSampleRateHz / mSettings->mBitRate;

U8 byte = mSerialText[ mStringIndex ];
mStringIndex++;
if( mStringIndex == mSerialText.size() )

mStringIndex = 0;
//we're currenty high
//let's move forward a little

mSerialSimulationData.Advance( samples per bit * 10 );

mSerialSimulationData.Transition(); //low-going edge for start bit

mSerialSimulationData.Advance( samples per bit ); //add start bit time

U8 mask = 0x1l << 7;

for ( U32 i=0; i<8; i++ )
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if( ( byte & mask ) != 0 )
mSerialSimulationData.TransitionIfNeeded ( BIT HIGH );
else

mSerialSimulationData.TransitionIfNeeded ( BIT LOW );

mSerialSimulationData.Advance( samples per bit );

mask = mask >> 1;

mSerialSimulationData.TransitionIfNeeded ( BIT HIGH ); //we need to end high

//lets pad the end a bit for the stop bit:

mSerialSimulationData.Advance( samples per bit );

There are a few things we could doto clean thisup. First, we could save the samples_per_bit as a
membervariable, and compute it only once, in the Initialize function. If we wanted to be more accurate,
we could use the ClockGenerator class to pre-populate an array of samples_per_bitvalues, soon
average the timingwould be perfect. We would use this asa lookup each time we Advance one bit.
Anotherthingwe coulddois use the DataExtractor class to take care of the bit masking/testing.
However, in oursimple example what we have works well enough, and it has the advantage of beinga
bitmore transparent.

Simulating Multiple Channels

Simulating multiple channels requres multiple SimulationChannelDescriptors, and they mustbe inan
array. The best way to thisisto use the helperclass, SimulationChannelDescriptorGroup.

Here is an example of 12C (2 channels) —these are the the membervaraible definitionsin
12cSimulationDataGenerator.h:

SimulationChannelDescriptorGroup mI2cSimulationChannels;
SimulationChannelDescriptor* mSda;

SimulationChannelDescriptor* mScl;
Then, inthe Initialize function:

mSda = mI2cSimulationChannels.Add ( settings->mSdaChannel, mSimulationSampleRateHz,
BIT HIGH );

mScl = mI2cSimulationChannels.Add ( settings->mSclChannel, mSimulationSampleRateHz,
BIT HIGH );

Andto provide the array to the caller of GenerateSimulationData:

*simulation channels = mI2cSimulationChannels.GetArray();

return mI2cSimulationChannels.GetCount () ;
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You can use each SimulationChannelDescriptor object pointer separately, calling Advance, Transition, etc

on each one, or you can manipulate themasagroup, usingthe AdvanceAll method of the

SimulationChannelDescriptorGroup object.

void AdvanceAll( U32 num samples to advance ) ;

Before returning from GenerateSimulationData, be sure that the Sample Number of all of your
SimulationChannelDescriptor objects exceed adjusted largest_sample_requested.

Examples of generating simulation data

void SerialSimulationDataGenerator::CreateSerialByte( U64 value )

51

void SerialSimulationDataGenerator: :CreateSerialByte( U64 value )

{

//assume we start high

mSerialSimulationData.Transition(); //low-going edge for start bit

mSerialSimulationData.Advance( mClockGenerator.AdvanceByHalfPeriod() ); //add
start bit time

if( mSettings->mInverted == true )

value = ~value;

U32 num bits = mSettings->mBitsPerTransfer;

BitExtractor bit extractor( value, mSettings->mShiftOrder, num bits );

for ( U32 i=0; i<num bits; i++ )

{

mSerialSimulationData.TransitionIfNeeded ( bit extractor.GetNextBit() );
mSerialSimulationData.Advance( mClockGenerator.AdvanceByHalfPeriod() ) ;
}
if( mSettings->mParity == AnalyzerEnums: :Even )

{

if( AnalyzerHelpers::IsEven( AnalyzerHelpers: :GetOnesCount ( value ) ) ==
true )

mSerialSimulationData.TransitionIfNeeded ( mBitlow ); //we want to
add a zero bit

else

mSerialSimulationData.TransitionIfNeeded ( mBitHigh ); //we want to
add a one bit
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mSerialSimulationData.Advance( mClockGenerator.AdvanceByHalfPeriod() );

}else
if( mSettings->mParity == AnalyzerEnums: :0dd )
{

if( AnalyzerHelpers::IsOdd( AnalyzerHelpers::GetOnesCount( value ) ) ==
true )

mSerialSimulationData.TransitionIfNeeded ( mBitLow ); //we want to
add a zero bit

else

mSerialSimulationData.TransitionIfNeeded ( mBitHigh );

mSerialSimulationData.Advance( mClockGenerator.AdvanceByHalfPeriod() );

mSerialSimulationData.TransitionIfNeeded ( mBitHigh ); //we need to end high

//lets pad the end a bit for the stop bit:

mSerialSimulationData.Advance( mClockGenerator.AdvanceByHalfPeriod( mSettings -
>mStopBits ) );

}

Note that above we use a numberof helperfunctionsand classes. Let’s discuss BitExtractor briefly.

BitExtractor
BitExtractor( U64 data, AnalyzerEnums::ShiftOrder shift order, U32 num bits );

BitState GetNextBit() ;

Some protocols have varaible numbers of bits perword, and settings forif the most significant bitis first
or last. This can be a pain to manage, so we made the BitExtraxtor class. This can be done by hand of
course if you like, butthis class tendstotidy up the code quite a bitin our experiece.

Similar, butreveresed, is the DataBuilder class, but as this generally used for collecting data, we’ll talk
more about itthen.

AnalyzerHelpers

Some statichelperfunctions that might be helpful, grouped underthe class AnalyzerHelpers, include:

static bool IsEven ( U64 value );
static bool IsOdd( U64 value );
static U32 GetOnesCount ( U64 value );

static U32 Diff32( U32 a, U32 b );
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void [2cSimulationDataGenerator::CreateBit( BitState bit_state )
void I2cSimulationDataGenerator::CreateBit( BitState bit state )

{
if( mScl->GetCurrentBitState () != BIT LOW )

AnalyzerHelpers: :Assert ( "CreateBit expects to be entered with scl low" );
mI2cSimulationChannels.AdvanceAll ( mClockGenerator .AdvanceByHal fPeriod( 0.5 ) );
mSda->TransitionIfNeeded( bit state );
mI2cSimulationChannels.AdvanceAll ( mClockGenerator .AdvanceByHal fPeriod( 0.5 ) );
mScl->Transition () ; //posedge
mI2cSimulationChannels.AdvanceAll ( mClockGenerator .AdvanceByHal fPeriod( 1.0 ) );

mScl->Transition () ; //negedge

}
void I2cSimulationDataGenerator::Createl2cByte( U8 data, I2cResponse reply )

void I2cSimulationDataGenerator::Createl2cByte( U8 data, I2cResponse reply )
{

if( mScl->GetCurrentBitState () == BIT HIGH )

{

mI2cSimulationChannels.AdvanceAll ( mClockGenerator .AdvanceByHal fPeriod (

mScl->Transition () ;

mI2cSimulationChannels.AdvanceAll ( mClockGenerator .AdvanceByHal fPeriod (

BitExtractor bit extractor( data, AnalyzerEnums::MsbFirst, 8 );

for ( U32 1=0; i<8; i++ )

{

CreateBit( bit extractor.GetNextBit () );

if( reply == I2C ACK )
CreateBit ( BIT LOW );
else

CreateBit( BIT HIGH );
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mI2cSimulationChannels.AdvanceAll ( mClockGenerator .AdvanceByHalfPeriod( 4.0 ) );

void I2cSimulationDataGenerator::Createl2cTransaction( U8 address, 12cDirection direction, U8 data

)

void I2cSimulationDataGenerator::Createl2cTransaction ( U8 address, I2cDirection
direction, U8 data )

{
U8 command = address << 1;
if( direction == I2C READ )

command |= 0x1;

CreateStart () ;

CreateI2cByte ( command, I2C ACK );
CreateI2cByte ( data, I2C ACK );
CreatelI2cByte ( data, I2C NAK );
CreateStop();

}

U32 I2cSimulationDataGenerator::GenerateSimulationData( U64 largest sample requested, U32

sample rate, SimulationChannelDescriptor** simulation channels )

U32 I2cSimulationDataGenerator::GenerateSimulationData( U64 largest sample requested, U32

sample_rate, SimulationChannelDescriptor** simulation channels )

{

U64 adjusted largest sample requested =
AnalyzerHelpers: :AdjustSimulationTargetSample ( largest sample requested, sample rate,

mSimulationSampleRateHz ) ;

while( mScl->GetCurrentSampleNumber () < adjusted largest sample requested )

{
CreatelI2cTransaction( 0xA0, I2C READ, mValue++ );

mI2cSimulationChannels.AdvanceAll ( mClockGenerator .AdvanceByHal fPeriod (
10.0 ) ); //insert 10 bit-periods of idle

}

*simulation channels = mI2cSimulationChannels.GetArray();

return mI2cSimulationChannels.GetCount () ;

void SpiSimulationDataGenerator::OutputWord_CPHA1(U64 mosi_data, U64 miso_data )

void SpiSimulationDataGenerator::OutputWord CPHALl( U64 mosi data, U64 miso data )

{
BitExtractor mosi bits( mosi data, mSettings->mShiftOrder, mSettings-
>mBitsPerTransfer );
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BitExtractor miso bits( miso_data, mSettings->mShiftOrder, mSettings-
>mBitsPerTransfer );

U32 count = mSettings->mBitsPerTransfer;

for ( U32 i=0; i<count; i++ )

{
mClock->Transition (); //data invalid
mMosi->TransitionIfNeeded ( mosi bits.GetNextBit() );

mMiso->TransitionIfNeeded ( miso bits.GetNextBit() );

mSpiSimulationChannels.AdvanceAll ( mClockGenerator .AdvanceByHalfPeriod ( .5

mClock->Transition(); //data valid

mSpiSimulationChannels.AdvanceAll ( mClockGenerator .AdvanceByHalfPeriod ( .5

mMosi->TransitionIfNeeded ( BIT LOW );

mMiso->TransitionIfNeeded ( BIT LOW );

mSpiSimulationChannels.AdvanceAll ( mClockGenerator .AdvanceByHalfPeriod( 2.0 ) );

void SpiSimulationDataGenerator::CreateSpiTransaction()
void SpiSimulationDataGenerator::CreateSpiTransaction ()

{
if( mEnable != NULL )

mEnable->Transition() ;
mSpiSimulationChannels.AdvanceAll ( mClockGenerator .AdvanceByHal fPeriod( 2.0 ) );
if( mSettings->mDataValidEdge == AnalyzerEnums::LeadingEdge )
{

OutputWord CPHAO ( mValue, mValue+l );

mValue++;

OutputWord CPHAO ( mValue, mValue+l );

mValue++;

OutputWord CPHAO ( mValue, mValue+l );

mValue++;

if( mEnable != NULL )
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mEnable->Transition() ;

OutputWord CPHAO ( mValue, mValue+l );
mValue++;

}else

OutputWord CPHAIL ( mValue, mValue+l );

mValue++;

OutputWord CPHAl ( mValue, mValue+l );

mValue++;

OutputWord CPHAl ( mValue, mValue+l );

mValue++;

if( mEnable != NULL )

mEnable->Transition() ;

OutputWord CPHAl ( mValue, mValue+l );

mValue++;

U32 SpiSimulationDataGenerator::GenerateSimulationData( U64 largest_sample_requested, U32
sample_rate, SimulationChannelDescriptor**simulation_channels )

56

U32 SpiSimulationDataGenerator::GenerateSimulationData( U64 largest sample requested, U32
sample rate, SimulationChannelDescriptor** simulation channels )

{

U64 adjusted largest sample requested =
AnalyzerHelpers: :AdjustSimulationTargetSample ( largest sample requested, sample rate,
mSimulationSampleRateHz ) ;

while( mClock->GetCurrentSampleNumber () < adjusted largest sample requested )
{

CreateSpiTransaction();

mSpiSimulationChannels.AdvanceAll ( mClockGenerator .AdvanceByHal fPeriod (
10.0 ) ); //insert 10 bit-periods of idle

}

*simulation channels = mSpiSimulationChannels.GetArray();

return mSpiSimulationChannels.GetCount () ;
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AnalyzerResults

After creating your SimulationDataGenerator class, working on your {YourNamej}AnalyzerResults files is
the nextstep.

AnalyzerResults is what we use to transform our resultsinto text fordisplay and as well as exported
files, etc.

Tip: You may end up finalizing may of the details about how your results are saved when you work on
your main Analyzerfile —{YourName}Analyzer.cpp/.h; You can simplyimplement the bare minimum of
the functionsinyour {YourName}AnalyzerResults.cpp file, and come back to it later.

{YourName}AnalyzerResults.h

In addition to the constructorand destructor, there are 5 functions we’ll need toimplement.
AnalyzerResults is fairly straightforward, so typically we won’t need much in the way of helperfunctions
or membervariables.

Here’sthe SimpleSerialAnalyzerResults headerfile. Yours will likevery similar, with the only difference
typically being the enums and/or defines you need.

#ifndef SIMPLESERIAL ANALYZER RESULTS

#define SIMPLESERIAL_ANALYZER_RES ULTS
#include <AnalyzerResults.h>

class SimpleSerialAnalyzer;

class SimpleSerialAnalyzerSettings;

class SimpleSerialAnalyzerResults : public AnalyzerResults
{
public:

SimpleSerialAnalyzerResults( SimpleSerialAnalyzer* analyzer,
SimpleSerialAnalyzerSettings* settings );

virtual ~SimpleSerialAnalyzerResults() ;

virtual void GenerateBubbleText( U64 frame index, Channel& channel, DisplayBase
display base );

virtual void GenerateExportFile( const char* file, DisplayBase display base, U32
export type user id );

virtual void GenerateFrameTabularText (U64 frame index, DisplayBase display base );
virtual void GeneratePacketTabularText ( U64 packet id, DisplayBase display base );

virtual void GenerateTransactionTabularText ( U64 transaction_ id, DisplayBase
display base );
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protected: //functions

protected: //vars
SimpleSerialAnalyzerSettings* mSettings;
SimpleSerialAnalyzer* mAnalyzer;

}i

#endif //SIMPLESERIAL ANALYZER RESULTS

{YourName}AnalyzerResults.cpp

In your constructor, save copies of the Analyzer and Settings raw pointers provided. There’s generally
nothingelse to dofor the constructoror destructor. Belowisan example from
SimpleSerialAnalyzerResults.cpp:
SimpleSerialAnalyzerResults: :SimpleSerialAnalyzerResults( SimpleSerialAnalyzer* analyzer,
SimpleSerialAnalyzerSettings* settings )
AnalyzerResults(),
mSettings( settings ),
mAnalyzer( analyzer )
{
}

Frames, Packets, and Transactions

The basicresultan analyzergeneratesis called a Frame. This could be byte of serial data, the header of
a CAN packet, the MOSI and MISO values from 8-bit of SPI, etc. Smallerelements, such the Startand
Stop eventsin|2C can be saved as Frames, are probably better saved as be graphical elements (called
Markers) and otherwise ignored. Collections of Frames make up Packets, and collections of Packets
make up Transactions.

95% of what you will be concerned aboutis Frames. What exactly a Framerepresentsisyourchoice,
but unlessyour protocol is fairly complicated (such as USB, CAN, Ethernet) the best betisto make the
Frame your main result element.

We'll getinto more detail regarding how to save yourresults when we describe to your Analyzer-derived
class.

Frame

A Frameis an object, with fairly genericmember variables which can be used to save results. Hereisthe
definition of a Frame:

class LOGICAPI Frame

{
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public:
Frame();
Frame( const Frameé& frame );

~Frame () ;

564 mStartingSampleInclusive;
S64 mEndingSampleInclusive;
U64 mDatal;
U64 mData2;
U8 mType;
U8 mFlags;

}i

A Framerepresents a piece of information conveyed by your protocol overan expanse of time. The
member variables mStartingSamplelnclusive and mEndingSamplelnclusive are the sample numbers for
the beginning and end of the Frame. Note that Frames may not overlap; they cannoteven share the
same sample. Forexample, if asingle clock edge ends one Frame, and starts a new Frame, thenyou’ll
needtoadd one (+1) to the mStartingSampleinclusive of the second frame.

In addition, the Frame can carry two 64-bit numbers as data. For example, inSPI, one of these is used
for the MISO result, and the otherfor the MISO result. Oftentimesyou’ll only use one of these
variables.

The mType variable isintended to be used to save a custom-defined enum value, representing the type
of Frame. Forexample, CAN can have many different types of frames —header, data, CRC, etc. Serial
only has one type, and it doesn’t use this membervariable.

mFlagsisintendedto be a holderfor custom flags which might apply to frame. Note thatthisis not
intended foruse with acustom an enum, butrather for individual bits that can be or'ed together. For
example, inSerial, there isaflagforframing-error, and a flag for parity error.

#define FRAMING ERROR FLAG ( 1 << 0 )

#define PARITY ERROR FLAG ( 1 << 1)

Two flags are reserved by the system, and will produce an error or warningindication onthe bubble
displayingthe Frame.

#define DISPLAY AS ERROR FLAG ( 1 << 7 )

#define DISPLAY AS WARNING FLAG ( 1 << 6 )

void {YourName}AnalyzerResults::GenerateBubbleText( U64 frame_index, Channel& channel,
DisplayBasedisplay_base)

GenerateBubbleText existsto retrieve textto putina bubble tobe displayed onthe screen. If youlike
you can leave thisfunction empty, and returntoit afterimplementing the rest of youranalyzer.
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The frame_indexisthe index to use to get the Frame itself —for example:
Frame frame = GetFrame( frame index );

Rarely, an analyzerneedsto display results on more than one channel (SPlis the only exampleof thisin
an analyzerwe make). If so, the channel whichisrequestingthe bubble is specified inthe channel
parameter. In most situations, this can simply be ignored. If you needto useit, just compare it to the
channels savedinyour mSettings object to see which bubble should be generated —for example, forthe
MISO or MOSI channel.

display_base specifies the radix (hex, decimal, binary) that any numerical values should be displayedin.
There are some helperfunctions provided so you should never have to deal directly with thisissue.

enum DisplayBase { Binary, Decimal, Hexadecimal, ASCII };

AnalyzerHelpers: :GetNumberString( U64 number, DisplayBase display base, U32

num data bits, char* result string, U32 result string max length );
In GetNumberString, above, note that num_data_bits isthe number of bits which are actually part of
your result. Forsample, forI2C, thisis always 8. It will depend on your protocol and possibly on user
settings. Providing this will let GetNumberString produce a well-formatted number with the right
amount of zero-padding forthe type of value under consideration.

Bubbles can display different length strings, depending on how muchroomis available. You should
generate several results strings. The simplest might simply indicate the type of contents (‘D’ fordata,
for example), longer ones mightindicate the fullnumber (“0xFF01”), and longerones might be very
verbose (“Left Channel Audio Data: 0xFF01”).

To provide strings to the caller, use the AddStringResult function. This will make sure that the strings
persistafterthe function has returned. Always call ClearResultStrings beforeadding any stringresults.

Note that to easily concatenate multiple strings, simply provide AddStringResult with more strings.

void ClearResultStrings () ;

void AddResultString( const char* strl, const char* str2 = NULL, const char* str3 = NULL,
const char* str4 = NULL, const char* str5 = NULL, const char* str6 = NULL ); //multiple
strings will be concatinated

Here’sthe Serial Analyzer’s GenerateBubbleText function:

void SerialAnalyzerResults::GenerateBubbleText( U64 frame index, Channel& /*channel*/,
DisplayBase display base ) //unrefereced vars commented out to remove warnings.

{

//we only need to pay attention to 'channel' if we're making bubbles for more than
one channel (as set by AddChannelBubblesWillAppearOn)

ClearResultStrings ();

Frame frame = GetFrame( frame index );

bool framing_error = false;
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if( ( frame.mFlags & FRAMING ERROR FLAG ) != 0 )

framing error = true;

bool parity error = false;
if( ( frame.mFlags & PARITY ERROR FLAG ) != 0 )

parity error = true;

char number str[128];

AnalyzerHelpers: :GetNumberString( frame.mDatal, display base, mSettings-
>mBitsPerTransfer, number str, 128 );

char result str[128];

if( ( parity error == true ) || ( framing error == true ) )

{
AddResultString( "!"™ );

no

sprintf( result str, %s (error)", number str );

AddResultString( result str );

if( parity error == true && framing error == false )

sprintf( result str, "$s (parity error)", number str );

else
if( parity error == false && framing error == true )

sprintf( result str, "%s (framing error)", number str );
else

sprintf( result str, "%s (framing error & parity error)",

number str );

AddResultString( result str );

}else

AddResultString( number str );

}
void {YourName}AnalyzerResults::GenerateExportFile( constchar* file, DisplayBase
display_base, U32 export type_user_id)

Thisfunctionis called whenthe usertriesto exportthe analyzerresultsto afile. If you like, you can
leave this function empty, and come back to it afterfinalizing the rest of youranalyzer design.

The file parameteris string containing the full path of the file you should create and write to with the

analyzerresults.
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std::ofstream file stream( file, std::ios::out );

The display_base parameter contains the radix which should be used to display numerical results. (See
GenerateBubbleText for more detail)

The export_type user_id parameteristhe id associated with the export-type the userselected. You
specify what these options are (there should be at least one) in the constructor of your AnalyzerSettings-
derivedclass. If youonly have one exportoption you canignore this parameter.

Oftentimesyou’ll wantto print out the time (in seconds) associated with a particularresult. Todo this,
use the GetTimeString helperfunction. You’ll need the trigger sample numberand the sample rate —
which can be obtained from your Analyzer object pointer.

U64 trigger sample = mAnalyzer->GetTriggerSample () ;
U32 sample rate = mAnalyzer->GetSampleRate();

static void AnalyzerHelpers: :GetTimeString( U64 sample, U64 trigger sample, U32
sample rate hz, char* result string, U32 result string max length );

Otherthan that, the implementation is pretty straightforward. Here isan example from

SerialAnalyzerResults.cpp:
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void SerialAnalyzerResults::GenerateExportFile( const char* file, DisplayBase
display base, U32 /*export type user id*/ )

{

//export type user id is only important if we have more than one export type.
std::ofstream file stream( file, std::ios::out );

U64 trigger sample = mAnalyzer->GetTriggerSample () ;

U32 sample rate = mAnalyzer->GetSampleRate();
file stream << "Time [s],Value,Parity Error,Framing Error" << std::endl;

U64 num frames = GetNumFrames();
for ( U32 i=0; i < num_ frames; i++ )
{

Frame frame = GetFrame( i );

//static void GetTimeString( U64 sample, U64 trigger sample, U32
sample rate hz, char* result string, U32 result string max length );

char time str([128];

AnalyzerHelpers: :GetTimeString ( frame.mStartingSampleInclusive,
trigger sample, sample rate, time str, 128 );

char number str[128];

AnalyzerHelpers: :GetNumberString( frame.mbDatal, display base, mSettings-
>mBitsPerTransfer, number str, 128 );
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file stream << time str << "," << number str;

if( ( frame.mFlags & FRAMING ERROR FLAG ) != 0 )
file stream << ",Error,";
else

file stream << ",";

if( ( frame.mFlags & FRAMING ERROR FLAG ) != 0 )

file stream << "Error";
file stream << std::endl;
if( UpdateExportProgressAndCheckForCancel( i, num frames ) == true )
{

file stream.close();

return;

file stream.close();

void SerialAnalyzerResults::GenerateFrameTabularText( U64 frame_index, DisplayBase

display_base)

GenerateFrameTabularTextis for producing text fortabulardisplay whichis not yetimplemented as of
1.1.5. You can safelyleaveitempty.

GenerateFrameTabularText is almost the same as GenerateBubbleText, exceptthatyoushould generate
onlyonetextresult. Ideallythe stringshould be concise, and only be acoupleincheslongorlessunder
normal (non error) circumstances.

Here is an example from SerialAnayzerResults.cpp:

void SerialAnalyzerResults::GenerateFrameTabularText( U64 frame index, DisplayBase
display base )

{
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Frame frame = GetFrame( frame index );

ClearResultStrings ();

bool framing error = false;
if( ( frame.mFlags & FRAMING ERROR FLAG ) != 0 )
framing error = true;
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bool parity error = false;
if( ( frame.mFlags & PARITY ERROR FLAG ) != 0 )

parity error = true;

char number str[128];

AnalyzerHelpers: :GetNumberString( frame.mDatal, display base, mSettings-
>mBitsPerTransfer, number str, 128 );

char result str[128];
if( parity error == false && framing error == false

{

AddResultString( number str );

lelse

if( parity error == true && framing error == false )

{
sprintf( result str, "$s (parity error)", number str );
AddResultString( result str );

lelse

if( parity error == false && framing error == true )

{
sprintf( result str, "$s (framing error)", number str );
AddResultString( result str );

}else

sprintf( result str, "%s (framing error & parity error)", number str );

AddResultString( result str );

}

void SerialAnalyzerResults::GeneratePacketTabularText( U64 packet id, DisplayBase
display_base)

Thisfunctionis usedto produce strings representing packet results forthe tabularview. Fornow, just
leave itempty. We’ll be updating the SDK and software to take advantage of this capability later.

void SerialAnalyzerResults::GenerateTransactionTabularText (U64 transaction_id,
DisplayBasedisplay_base)

Thisfunctionisusedto produce strings representing packet results forthe tabularview. Fornow, just
leave itempty. We’ll be updatingthe SDK and software to take advantage of this capability later.
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Analyzer

Your Analyzer-derived class is the heart of the analyzer. It’s here were we analyze the bits comingin —in
real time —and generate analyzerresults. Otherthana few otherhousekeepingthings, that’sit. Let’s
getstarted.

{YourName}Analyzer.h

In additionto the constructorand destructor, here are the functionsyou’ll need toimplement:

virtual void WorkerThread () ;

virtual U32 GenerateSimulationData( U64 newest sample requested, U32 sample rate,
SimulationChannelDescriptor** simulation channels );

virtual U32 GetMinimumSampleRateHz();

virtual const char* GetAnalyzerName () const;

virtual bool NeedsRerun () ;

extern "C" ANALYZER EXPORT const char*  cdecl GetAnalyzerName();
extern "C" ANALYZER EXPORT Analyzer*  cdecl CreateAnalyzer( );

extern "C" ANALYZER EXPORT void _ cdecl DestroyAnalyzer ( Analyzer* analyzer );
You'll also need these membervariables:

std::auto ptr< {YourName}AnalyzerSettings > mSettings;
std::auto ptr< {YourName}AnalyzerResults > mResults;
{YourName}SimulationDataGenerator mSimulationDataGenerator;

bool mSimulationInitilized;

You'll also need one AnalyzerChannelData raw pointerforeachinput. For SerialAnalyzer, forexample,
we need

AnalyzerChannelData* mSerial;

As you develop youranalyzer, you’lladd additional member variables and helper functions dependning
on youranalysis needs.

{YourName}Analyzer.cpp
Constructor

Your constructor will look something like this

{YourName}Analyzer::{YourName}Analyzer ()
Analyzer (),
mSettings( new {YourName}AnalyzerSettings() ),

mSimulationInitilized( false )
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SetAnalyzerSettings( mSettings.get() );
}

Note that here you’re calling the base class conststructor, newing your AnalyzerSettings-derived class,
and providing the base class with a pointertoyour AnalyzerSettings-derived object.

Destructor

Thisonly thingyour destructor mustdois call KillThread. Thisis a base class memberfunctionand will
make sure your class destructsin the right order.

void {YourName}Analyzer:WorkerThread()

This function the key to everything —it’s where you’ll decodethe incoming data. Let’sleave itemptyfor
now, and we'll discuss in detail once we complete the otherhousekeeping functions.

bool {YourName}Analyzer::NeedsRerun()
Generally speaking, justreturn falsein this function. For more detail, read on.

Thisfunctionis called whenyouranalyzerhas finished analyzing the collected data (this conditionis
detected from outside your analyzer.)

This function gives you the opportunity torun the analyzerall overagain, on the same data. To do this,
simplyreturn true. Otherwise, return false. The only thingthisis currently usedforisforour Serial
analyzer, for “autobaud”. When usingautobaud, we don’t know ahead of time what the serial bit rate
will be. If the rate turns out to be significantly different fromthe rate we ran the analysis at, we return
true to re-runthe analysis.

If you return true, that’s all thereisto do. Your analyzerwill be re-run automatically.

U32 {YourName}Analyzer::GenerateSimulationData( U64 minimum_sample_index, U32
device_sample_rate, SimulationChannelDescriptor**simulation_channels )

Thisis the function that gets called to obtain simulated data. We made a dedicated class forhandling
thisearlier—we just need to do some housekeeping here to hookit up.
U32 {YourName}Analyzer: :GenerateSimulationData( U64 minimum sample index, U32
device sample rate, SimulationChannelDescriptor** simulation channels )
{
if( mSimulationInitilized == false )

{

mSimulationDataGenerator.Initialize ( GetSimulationSampleRate (),
mSettings.get () );

mSimulationInitilized = true;
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return mSimulationDataGenerator.GenerateSimulationData( minimum sample index,
device sample rate, simulation channels );

}

U32 SerialAnalyzer::GetMinimumSampleRateHz()

Thisfunctioniscalledtosee if the user’s selected sample rate is sufficient to get good results for this
analyzer.

For Serial, forinstance, we would like the samplerate to be x4 higher that the serial bit rate.

For other, typically synchronous, protocols, you may not ask the userto enterthe data’s bit rate —
therefore you can’t know ahead of time whatsample rate is required. Inthat case, you can either
return the smallest sample rate (25000), or return a value that will be fast enough for your simulation.
However, yoursimulation really should adjustits own rate depending on the sample rate —for example,
when simulation SPlyou should probably make the bit rate somethinglike 4x the sample rate. Thiswill
allow the simulationtowork perfectly no matter whatthe sample rate is.

The rule of thumbisto require oversampling by x4if you know the data’s bit rate, otherwise justreturn
25000.

Here’s whatwe do in SerialAnalyzer.cpp

U32 SerialAnalyzer::GetMinimumSampleRateHz ()

{

return mSettings->mBitRate * 4;

}
constchar* {YourName}Analyzer::GetAnalyzerName() const
Simply returnthe name youwould like tosee inthe “Add Analyzer” drop down.

return "Async Serial";

constchar* GetAnalyzerName()

Returnthe same stringas inthe previous function.
return "Async Serial";

Analyzer* CreateAnalyzer()

Return a pointerto a new instance of your Analyzer-derived class.
return new {YourName}Analyzer();

void DestroyAnalyzer(Analyzer*analyzer )

Simply call delete on the provided pointer.
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delete analyzer;

void {YourName}Analyzer:WorkerThread()

Ok, now that everythingelseis taken care of, let’'slook atthe mostimportant part of the analyerin
detail.

First, we’ll new our AnalyzerResults-derived object.
mResults.reset( new {YourName}AnalyzerResults( this, mSettings.get() ) );
Well provide a pointerto our results to the base class:

SetAnalyzerResults ( mResults.get () );

Let’sindicate which channels we’ll be displaying results on (in the form of bubbles). Usually this will
only be one channel. (Exceptinthe case of SPI, where we’ll want to put bubbles on both the MISO and
MISO lines.) Onlyindicate where we willdisplay bubbles —other markup, like tick marks, arrows, etc,
are notbubbles, and should not be reported here.

mResul ts->AddChannelBubblesWill1AppearOn( mSettings->mInputChannel );

We'll probably wantto know (and save in a membervariable) the sample rate.

mSampleRateHz = GetSampleRate();

Now we need to get accessto the data itself. We’ll need to get pointersto AnalyzerChannelData objects
for each channel we’ll need datafrom. For Serial, we’ll just need one. ForSPIl, we mightneed 4. Etc.

mSerial = GetAnalyzerChannelData( mSettings->mInputChannel );

We’ve now ready to start traversing the data, and recording results. We’ll look at each of these tasksin
turn.

First,a word of advice

A protocol is typically fairly straightforward, when it behaves exactly asit supposed to. The more your

analyzerneedsto deal with exceptionstothe rule, the more sophisticatedit’llneed to be. The bestbet
is probably to start as simple as possible, and add more “gotchas” as they are discovered, ratherthanto
try and design an elaborate, bulletproof analyzer from the start, especially whenyou’re new to the API.

AnalyzerChannelData

AnalyzerChannelData is the class that will give us access to the data froma particularinput. This will
provide dataina serialized form —we will not have “randomaccess” to any bitin the saved data.
Rather, we will start at the beginning, and move forward as more data becomes available. Infactwe’ll
never know when we’re atthe “end” of the data or not — attempts to move forward in the stream will
block until more data becomes available. This will allow ouranalyzerto process datain a real -time
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manner. (It may backlog, of course, ifit can’t keep up —although generally the collection will end at
some pointand we’ll be able tofinish).
AnalyzerChannelData - State

If we’re notsure where are inthe stream, or if the inputis currently high orlow, we can just ask:

U64 GetSampleNumber () ;

BitState GetBitState();

AnalyzerChannelData - Basic Traversal
We’ll need some ability to move forward in the stream. We have three basicways to do this.
U32 Advance( U32 num_samples );

We can move forward in the stream by a specificnumber of samples. Thisfunction will return how
many timesthe inputtoggled (changed from ahigh to a low, or low to a high) to make this move.

U32 AdvanceToAbsPosition( U64 sample_number );

If we wantto move forward to a particular absolute position, we can use this function. Italsoreturns
the number of times the input changed duringthe move.

void AdvanceToNextEdge();

We also might wantto move forward until the state changes. Aftercallingthisfunctionyoumightwant
to call GetSampleNumberto find out how far you’ve come.

AnalyzerChannelData - Advanced Traversal (looking ahead without moving)

As you develop youranalyzer(s)certain tasks may come up that call for more sophisticated traversal.
Here are some ways of doingit.

U64 GetSampleOfNextEdge();

Thisfunction does not move your positionin the stream. Remember, you can not move backwardinthe
stream, so sometimes seeing what’s up ahead without moving can be very important.

bool WouldAdvancingCauseTransition( U32 num_samples );

This function does not move your positioninthe stream. Here you find out if moving forward a given
numberof samples would cause the bit state (low or high) to change.

bool WouldAdvancingToAbsPositionCauseTransition( U64 sample_number );

Thisis the same as the prior function, except you provide the absolute position.
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AnalyzerChannelData - Keeping track of the smallest pulse.

When we were implementing Serial’s “autobaud” it was clear that keepingtrack of the minimum pulse
length overthe entire stream was overly cumbersome. If you need this capability forsome reason,
these functions will provide it foryou (it’s turned off by default)

volid TrackMinimumPulseWidth() ;

U64 GetMinimumPulseWidthSoFar();

Filling in and saving Frames

Usingthe above AnalyzerChannelData class, we can now move through a channel’s dataand analyze it.
Now let’s discus how to store results.

We described Frames when talking aboutthe AnalyzerResults-derived class. A Frameis the basicunit
resultsare savedin. Frames have:

e startingand endingtime (startingand ending sample number),
e x264-bitvaluestosaveresultsin

e an 8-bittype variable —to specify the type of Frame

e an 8-bitflagsvariable —to specify Yes/No types of results.

When we have analyzed farenough, and now have a complete Frame we would like to record, we do it
like this:

Frame frame;

frame.mStartingSampleInclusive = first sample in frame;
frame.mEndingSampleInclusive = last sample in frame;

frame.mbDatal = the data we collected;

//frame.mbData2 = some more data we collected;

//frame.mType = OurTypeEnum; //unless we only have one type of frame

frame.mFlags = 0;

if( such _and such error == true )
frame.mFlags |= SUCH AND SUCH ERROR _FLAG | DISPLAY AS ERROR FLAG;
if( such_and such warning == true )
frame.mFlags |= SUCH AND SUCH WARNING FLAG | DISPLAY AS WARNING FLAG;

mResults->AddFrame ( frame );
mResults->CommitResults () ;

ReportProgress( frame.mEndingSampleInclusive );

Firstwe make a Frame on the stack. Thenwefillinallitsvalues. If there’savalue youdon’tneed, to
save time you can skip settingit. mFlags should always be setto zero, however, because certan pre-
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defined flags will cause the results bubbletoindicate awarningorerror (DISPLAY AS WARNING_FLAG,
and DISPLAY _AS_ERROR_FLAG).

Part of the Frameis expectedtobe filledin correctly becauseit’s used automaticly by othersystems. In
particular,

o mStartingSampleInclusive
o mEndingSampleInclusive

o mFlags

should befilled in properly.

Other parts of the Frame are only there soyou can create text descriptions orexportthe datato a
desired format.

To save a Frame, Use AddFrame from your AnalyzerResults-derived class. Note that frames must be
addedin-order, and must notoverlap. In other words, you can’t add a Frame from an earliertime
(smallersample number) afteraddinga Frameform a latertime (larger sample number).

Immediately afteradding a Frame, call CommitResults. This makes the Frame accessable to the external
system.

Also call the Analyzerbase class ReportProgress. Provide itwith itthe largest sample number you have
processed.

Adding Markers

Makers are visual elements you can place on the waveformto highlight various waveform features as
they relate toyour protocol. For example, in ourasynchronous serial analyzer, we place little white dots
at the locations where we samplethe input’s state. You can also use markersto indicate where the
protocol falls out of specification, arising or falling clock edge, etc. Youspecify whereto putthe marker
(the sample number), which channel to displayiton, and which graphical symbol to use.

void AddMarker( U64 sample number, MarkerType marker type, Channel& channel );
For example, from SerialAnalyzer.cpp:
mResults->AddMarker( marker location, AnalyzerResults::Dot, mSettings->mInputChannel );

Currently, the available graphical artifacts are

enum MarkerType { Dot, ErrorDot, Square, ErrorSquare, UpArrow, DownArrow, X, ErrorX,
Start, Stop, One, Zero };

Like Frames, you mustadd Markersin order.

Markers are strictly forgraphical markup, they can not be usedto help generate display text, export
files, etc. Only Frames are accessable to do that.
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Packets and Trasactions

Packets and Trasactions are only moderatly supported as of now, but they will be becoming more
prominate inthe software.

Packets are sequential collections of Frames. Grouping Frames into Packets as you create themis easy:

U64 CommitPacketAndStartNewPacket () ;

void CancelPacketAndStartNewPacket () ;

Whenyouadd a Frame, it will automatically be added to the current Packet. When you’ve added all the
Framesyouwant ina Packet, call CommitPacketAndStartNewPacket. In some conditions, especially
errors, you will want starta new packet without committing the old one. Forthis, call
CancelPacketAndStartNewPacket.

Note that CommitPacketAndStartNewPacket returns an packetid. Youcan usethisidto assigna
particular packetto a transaction.

void AddPacketToTransaction( U64 transaction id, U64 packet id );

The transaction_idis an ID you generate yourself.

The analyzers created by Saleae do not yet use Transactions, and the current Analyzer probably never
will. Transactions are provided for higher-level protocols, and you may not wantto bother, especially
since theyaren’tusedinthe Logic software yet. We will use Transactionsin analyzers for more
sophisticated protocolsin the future.

Packets on the otherhand tendto be fairly applicable forlowerlevel protocls, although not in entirly the
same ways. For example:

e Serial Analyzer—no packet support makes sense atthislevel. (there are many more structured
protocols that use asynchronous serial where packets would be applicable)

e SPlAnalyzer—packetsare usedto delimitbetween periods when the enable line is active.

e |2C Analyzer—packets are used to delimit periods between a start/restart and a stop.

e CAN Analyzer—packetsare usedto represent, well, CAN packets.

e UNI/O- packetsare usedtogroup Framesina UNI/Osequence.

e 1-Wire— packetsare usedto group 1-Wire sequences.

e 12S/PCM—packetsaren’tused.

Currently, Packets are only used when exporting datato text/csv. In the future, analyzertabularviews
will support nesting Frames into Packets, and identifying Transactions (ids) associated with particular
Packets. Generatingthe textual contenttosupportthisis providedinyour AnalyzerResults-derived
class.
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When using Packet ids when exporting data to text/csv, use the GetPacketContainingFrameSequential
function, to avoid searching forthe packet everytime. The GetPacketContainingFrame will do afull
searchand be muchless efficient.
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